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1  Introduction

1.1  About This Manual

This instruction manual is intended to serve as a guide for operating the JASCO
Spectra Analysis program and the JASCO File Find program, both designed to run
on Microsoft Window 95/98/NT4.0. This manual consists of three sections (including
this section) and an appendix.  The contents of each section are briefly described
below.
The JASCO Spectra Analysis program can be used with various JASCO
spectrometers, for example, UV/VIS and UV/VIS/NIR spectrophotometers,
spectrofluorometers, FT/IR and Circular Dichroism spectropolarimeters. The screen
examples used throughout this manual are taken from screens displayed when the
JASCO Spectra Analysis program is used with a UV-Visible spectrophotometer. That
is, either absorbance or transmittance are shown on the abscissa (vertical axis).
When using the JASCO Spectra Analysis program with a different spectrometer, the
relevant abscissa will be displayed. For example, for a spectrofluorometer intensity
will typically be displayed on the abscissa.
Note: Refer to the Measurement manual for notation conventions and how to open

and close the program.
The Measurement manual describes procedures ranging from measurement
to spectrum analysis. Refer to it, as and if necessary.

1 Introduction
Contains a description of how to use this manual, an overview of the Spectra
Analysis program, and the screen configuration and basic operation of the
Spectra Analysis program. Read this section first.

2 Spectra Analysis Program: Reference
Contains reference information for the Spectra Analysis program. The Spectra
Analysis program performs data processing operations such as peak find,
difference spectrum calculation, differentiation, and smoothing.

3 File Find Program: Reference
Contains reference information for the File Find program. The File Find program is
used to search for a previously saved spectrum.

4 Appendix
Contains various technical information for the Spectra Analysis program.

1.2  Spectra Analysis Program Overview

The main Spectra Analysis program functions are as follows.
(1) File functions: Save, load or print spectra.
(2) Edit functions: Copy a spectrum to the clipboard or between views. Delete a

spectrum.
(3) View functions: Change spectrum characteristics such as the scale, color, or font.

Display or hide peak find results.
(4) Data processing functions:

• Correction
Baseline correction: Corrects a spectrum with a designated baseline.
Smoothing: Smoothes the spectrum.
Noise elimination: Eliminates noise of known cause.
Deconvolution: Separates overlaid peaks.
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FFT filter: Eliminates noise.
Data Cut: Cuts out unwanted data.

• Arithmetic
Arithmetic: Performs arithmetic operations between spectra or

with a spectrum and a constant.
Derivative: Differentiates a spectrum.
KK conversion Performs Kramers-Kronig conversion.

Note: The KK conversion function is only applicable for spectra for which the
vertical axis is either absorbance(Abs), %T or %R.

• Peak
Peak find: Finds spectrum peaks (or valleys).
Peak height: Calculates the peak height and peak height ratio.
Peak area: Calculates the peak area and peak area ratio.
Peak width: Calculates the full width at half maximum value.

• Subtraction: Calculates a difference spectrum.
• X Unit Conversion: Converts the X-axis units of the spectrum.
• Y Unit Conversion: Converts the Y-axis units of the spectrum.

Note: The Y unit conversion function is only applicable for spectra for which the
vertical axis is either or absorbance(Abs), %T or %R.

• Other
Comment Adds/edits comments.

• Common options
Kinetics Calculates enzyme activity.
Data Dump Displays measured data values.
Move Channel Move channels (for example, channel 1 and

channel 2) in a view or pick up only data of a
desired channel from data overlaid in a view
or from multiple-channel data.

Arithmetic with Data Performs arithmetic operation on data overlaid
in the same channel of a View.

Arithmetic with Channel Performs arithmetic operation on data
displayed in the same View.

Data Accumulation Accumulates the data overlaid in the same
channel of a View and displays the
accumulated data in a new View.

• IR Option
ATR conversion Converts the absorption intensity relationship

between the high wavenumber side and low
wavenumber side.

IF -> spectrum Converts an intrferogram(IF) into a single-
beam spectrum.

Spectrum -> IF Convert a single-beam spectrum into an
interferogram(IF).

• FP Option
Phospho. Lifetime Calculates the phosphorescent Lifetime.

• CD-options
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HT → OD conversion Converts HT voltage data into absorbance.
Optical constant calculate Calculates optical constants.
KK conversion Performs Kramers-Kronig conversion.
G Value Calculates G value.
pH Conversion Performs pH conversion.

1.3  [Spectra Analysis] Window

When the [Spectra Analysis] program starts up, the following window appears.
Note: Two or more windows may appear in order to display data. Each of these

windows is referred to as a "View". Multiple data can be overlaid in one View.

Note: The [Spectra Analysis] program starts automatically when either spectrum
measurement or time-course measurement is performed and the
measurement data are displayed in a View window.

Spectrum legend display field Tool bar

View

Status bar

Fig. 1.1  [Spectra Analysis] window

Spectrum legend display Displays the name of the active spectrum in the
active View. Clicking the arrow at the right
displays a list of all spectra overlaid in the View.
Here, the active spectrum can be changed over.

Tool Bar Contains buttons for frequently used functions.
The buttons/functions described in Section 1.4
“Tool Bar” can only be found in the tool bar (i.e.
they do not appear in the program menus). Other
functions contained in the program menus can
also be registered in the tool bar (up to a
maximum of 10).

View A window that displays a spectrum (or spectra).
The filename of the active spectrum is displayed
in the title bar of the View window.

Status bar Displays the wavelength and data corresponding
to the currently selected position. To select a
position, move the mouse pointer to the desired
position and click once with the left mouse
button.
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1.4  Tool Bar

The tool bar contains frequently used functions. In addition to the standard tool bar
buttons, buttons corresponding to other functions contained in the program menus
can also be registered (up to a maximum of 10). By clicking the appropriate button on
the tool bar the corresponding function can be executed directly.
The first eight buttons below are used to change the scale settings.

Used to change x-axis scale.

Used to change y-axis scale

Reduces the spectrum horizontally (when  is depressed) or

vertically (when  is depressed).

Expands the spectrum horizontally (when  is depressed) or

vertically (when  is depressed).

Moves the spectrum to the left (when  is depressed) or up

(when  is depressed).

Moves the spectrum to the right (when  is depressed) or

down (when  is depressed).
Redisplays vertical axis at auto scale

Redisplays data at full scale (displays all regions).

Returns to default scale settings.

Activates the function for changing the scale using the mouse.

Changes the active data

Toggles between Overlay/Normalize
Normalize is used to display a spectrum with auto

scaling.

Equivalent to [File]-[Open...]

Equivalent to [File]-[Print...]

Click the  button on the tool bar to change between active data.

Click the  button of the tool bar to switch between simple trace and spectrum
extension functions.

The  button is not depressed during simple trace (i.e., the spectrum expansion
function is off).
Press and hold the left mouse button at any position on the spectrum display. A
vertical line appears at that position and the wavelength (or point) and data at that
position are displayed in the status bar. The vertical line disappears when the mouse
button is released. Use [Trace] in the [View] menu to trace all data points.

The  button is depressed during spectrum expansion (i.e., the spectrum
expansion function is on)
Used the mouse to designate the expansion range. To designate the range, press
and hold the mouse button at one of the corners of the desired range. Drag the
cursor diagonally to the opposite corner. This creates a rectangular region which will
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be expanded. Release the mouse button and the designated range is displayed. The
scale changes accordingly. Click the right mouse button to return the display to its
original scale. To designate a precise scale change, use [Scale] in the [View] menu.
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2  Spectra Analysis Program Menu: Reference

To start the Spectra Analysis program, in the [Analysis] pane of [Spectra Manager]
double-click on [Spectra Analysis]. The [Spectra Analysis] program starts up and the
following window appears.
Note: The Spectra Analysis program can be used with various JASCO

spectrometers, for example, UV/VIS and UV/VIS/NIR spectrophotometers,
spectrofluorometers, FT/IR and Circular Dichroism spectropolarimeters. The
screens and examples used in the descriptions throughout this manual are
for spectra measured using a UV-Visible spectrophotometer (absorbance or
transmittance on the abscissa). When using the Spectra Analysis program
with a spectrofluorometer, emission intensity will typically be displayed on
the abscissa.

Fig. 2.1  [Spectra Analysis] window

2.1  [File] Menu

This section describes the commands contained in the [File] menu.
[Open...] Displays the [Open New File] dialog box used to open

previously saved spectra. Multiple files can be selected and
opened at the same time.

[Overlay...] Displays the [Overlay Additional File] dialog box used to add a
spectrum to the active View. Multiple files can be selected and
added at the same time.

[Close] Closes the active View.  If spectrum data have not been saved,
a message prompt appears asking the operator whether to
save the data before closing.

[Save] Saves the active spectrum in the active View under the current
filename. Previous data are overwritten.

[Save As...] Displays the [Save As] dialog box used to save the active
spectrum in the active View under a new filename and/or in a
new location.

[Find...] Starts the File Find program.
[Print...] Prints the active spectrum.
[Print
Preview...]

Displays the [Preview] dialog box which shows how the active
view will look when printed.

[Print Displays the [Print Setup] dialog box used to designate the



7

Setup...] target printer and set print parameters.
[Exit] Exits the Spectra Analysis program. If spectrum data have not

been saved, a message prompt appears asking the operator
whether to save the data before exiting.

2.1.1  [Open...]

Select [File] - [Open...] to display the [Open New File] dialog box used to open a
spectrum (or spectra) in a new View. Multiple files can be selected at one time and
opened in the same View or in separate Views.

Fig. 2.2  [Open New File] dialog box

[Look in] Used to designate the drive or directory that holds the
files you want. Available drives and directories appear in
the drop-down list.
The contents of the drive or directory designated in the
[Look in] drop-down list are shown in the box below.
Select the desired spectrum file name. To select multiple
non-sequential files, click on the desired spectra file
names while holding down the [Ctrl] key. To select any
number of sequential files click on the first and last file
names of the desired list while holding down the [Shift]
key. Spectra with different extensions cannot be selected
simultaneously unless [All files] has been designated as
the file type.

[File name] Used to directly input the desired spectrum filename(s).
To select multiple files, input each filename separated by
a space. The extension may be omitted. If an incorrect
extension is input, the designated extension is
substituted automatically.

[Files of type] Lists the file types (extensions) that can be opened with
the Spectra Analysis program. If the extension is omitted
when the file name is input, the file extension designated
here is added automatically. When [All files] is
selected, .jws is added automatically.

The following file types can be designated:
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Standard data (*.jws): Data measured and calculated
using the Spectra Analysis
program.

JCAMP-DX (*.dx): Data in JCAMP-DX 4.24 format.
Refer to JCAMP-DX Format Files
for a description of the format
that can be handled.

All files (*.*): Designates all files. Files not in
one of the formats described
above cannot be loaded.

[Multi View] Check to open multiple files in separate Views. If [Multi
View] is not selected, the data are overlaid in a single
View.

[Preview]
Clicking the [Preview] button  displays a preview of
the contents of the currently selected file and spectrum
or information in file directory appears. When multiple
files are selected, the preview pane displays the contents
of the last file selected.

Fig. 2.3  [Open New File] dialog box showing the file preview pane

2.1.2  [Overlay...]

Select [File] - [Overlay...] to display the [Overlay Additional File] dialog box used to
add a spectrum (or spectra) to the active View. Multiple files can be selected and
added at the same time. The vertical axis is automatically re-scaled so that all of the
spectra to be overlaid are displayed, however, the horizontal axis is not changed.



9

Fig. 2.4  [Overlay Additional File] dialog box

2.1.3  [Close]

Closes the active View. The following dialog box appears when there are spectra that
have not been saved. Click [Yes] to save the spectra before closing. Click [No] to close
without saving.  Click [Cancel] to cancel closing the active View.

Fig 2.5  Message displayed before closing when there are spectra that have not been
saved.

2.1.4  [Save]

Select [File] - [Save] to save the active spectrum in the active View under the current
filename. Previous data are overwritten.

2.1.5  [Save As...]

Select [File] - [Save As...] to display the [Save As] dialog box used to save the active
spectrum in the active View under a new filename and/or in a new location.

Fig. 2.6  [Save As] dialog box
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[Save in] Used to designate the destination drive or directory.
Available drives and directories appear in the drop-down
list.
The contents of the drive or directory designated in the
[Look in] drop-down list are shown in the box below. To
use an existing filename click on the desired filename.

[File name] Used to directly input the desired spectrum filename. If
the extension is omitted, the designated extension is
added automatically. If an existing filename is
designated and the <Save> button is clicked, the
following dialog box appears.

Fig 2.7  Dialog box displayed when an existing filename is designated

Click <OK> to overwrite the contents of the original file.

[Save as type] Lists the available save file types (extensions). If the
extension is omitted when the file name is input, the file
extension designated here is added automatically.

The following file types can be designated.

Standard data (*.jws): Data measured and calculated
using the Spectra Analysis
program.

JCAMP-DX_(*.dx): Data in the JCAMP-DX 4.24
format. Refer to the Appendix
"JCAMP-DX Format Files" for
acceptable formats.

Text File (*.TXT): Data in text format.
<Comment> Click to display the [Comment Edit] dialog box used to

enter/edit sample name, operator, organization and
comment associated with the file.

2.1.6  [Search...]

Starts the File Find program. Refer to Section 3 “File Find Program” for instructions
on how to search for JASCO spectrum files.

2.1.7  [Print...]

Select [File] - [Print...] to print the active View. The spectrum line style, frame, grid,
and font, etc are printed according to the designated parameters in [Pattern...],
[Font...], and [Style...] in the [View] menu.
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If the [Ask the title for printing] box is checked in the [Print] tab of the [Customize]
dialog box ([Other] – [Customize…]), when [File] - [Print...] is selected the [Print]
dialog box shown below is displayed.

Fig 2.8  [Print] Dialog Box

[Print Title] Check to print the active view with a title. Enter a title
in the text box below.

[Legend] group Controls whether a legend is printed for spectra.
[Always] A legend is always printed.
[Never] A legend spectra is never printed.
[When Multiple Data
Displayed]

A legend is printed when two or more spectra are
displayed in the active View.

[Print Form] group Designates the print format.
[Fixed Form] Select to print using standard format
[Standard Form] Select to print using the standard format.
[User Form] Select to print using a template file created in JASCO

Canvas. Click the [Browse] button and designate the
JASCO Canvas template file to be used.

<Setup> Opens the [Print Setup] dialog box used to designate
the target printer and print parameters.

<Preview> Shows how the active View will look when printed.

2.1.8  [Print Preview...]

This shows how the active View will look when printed.
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Fig 2.9  [Preview] Dialog Box
<Print> Prints the active View.
<Close> Closes the [Preview] window without printing.

2.1.9  [Print Setup...]

Select [File] - [Print Setup...] to designate the target printer and print parameters.

Fig. 2.10  [Print Setup...] Dialog Box

[Printer] group Click the [Default printer] option button
to use the Windows default printer.
Click the [Specific printer] option
button and select the desired printer
from the drop-down list below to use a
different printer.

[Orientation] group
[Portrait] Prints the View so that the short edge

of the paper is the top of the page.
[Landscape] Prints the View so that the long edge

of the paper is the top of the page.
[Paper] group

[Size] Select the paper size from the drop-
down list.

[Source] Select the paper source tray from the
drop-down list.

<Options...> Used to designate parameters for the
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target printer. The dialog box that
appears differs according to the target
printer.

2.1.10  [Exit]

Select [File] - [Exit] to exit the Spectra Analysis program. The following message
appears when unsaved spectra exist. To save the spectra, click <Yes>.

Fig. 2.11  Message displayed when unsaved files exist

<Yes> Spectra are saved and the Spectra Analysis program
ends.

<No> The Spectra Analysis program ends without saving data.
<Cancel> Cancels the [Exit] command and returns to the active

View.

2.2  [Edit] Menu

This section describes the commands contained in the [Edit] menu.

2.2.1  [Copy Picture]

Select [Edit] - [Copy Picture] to copy a spectrum to the clipboard as a picture. The
spectrum can then be pasted into draw-type software such as Microsoft Draw for
editing.

2.2.2  [Copy Bitmap]

Select [Edit] - [Copy Bitmap] to copy a spectrum to the clipboard as a bitmap. The
spectrum can then be pasted into paint-type software such as Paintbrush for editing.
The image becomes distorted if the bitmap is expanded or reduced. Therefore, the
size of the window (spectrum) should be adjusted accordingly before copying. A good
figure can be obtained if care is taken not to change the ratio between the left and
right lengths when reducing later. Expansion always distorts the image.

2.2.3  [Cut Spc.]

Select [Edit] - [Cut Spc.] to remove the currently selected spectrum from the active
view and transfer it to the clipboard. When [Select all Spc.] is checked, all the spectra
in the active View are cut and the View is closed. Use this command or the [Copy
Spc.] command, to place spectra from different Views into one View.

2.2.4  [Copy Spc.]

Select [Edit] - [Copy Spc.] to copy the currently selected spectrum in the active View
to the clipboard. The original spectrum remains in the active View. When [Select all
Spc.] is checked, all spectra in the active view are copied. Use this command to
place spectra from different views into one View.
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2.2.5  [Paste Spc.]

Select [Edit] - [Paste Spc.] to paste the contents of the clipboard into the active View.

2.2.6  [Delete Spc.]

Deletes the currently selected spectrum in the active View. When [Select all Spc.] is
checked, all spectra in the active view are deleted and the View closes.

Note: When a spectrum is erased, the color of the remaining spectra may change.

2.2.7  [Select all Spc.]

Select [Edit] - [Select all Spc.] to select/deselect all spectra in the active View. When
[Select all Spc.] is checked all spectra in the active View are selected. This function
can be used in combination with [Cut Spc.], [Copy Spc.] and [Delete Spc.].

2.3  [View] Menu

This section describes the commands contained in the [View] menu.

[Scale...] Displays the [Scale] dialog box used to change the scale
of the spectrum/spectra displayed in the active View.

[Pattern...] Displays the [Pattern Settings] dialog box used to select
the line style and color of the spectrum/spectra displayed
in the active View.

[Font...] Displays the [Font] dialog box used to select the font
settings and orientation for the active View.

[Grid...] Displays the [Grid lines] dialog box used to add/remove
vertical and/or horizontal lines to the active View.

[Style...] Displays the [Scale Setting] dialog box used to change
the scale settings for the active View.

[Horizontal Axis...] Displays the [Horizontal Axis] dialog box used to change
the horizontal axis.

[Information...] Displays spectrum information for the currently selected
spectrum in the active View.

[Normalize] Normalizes the scale of each spectrum displayed in the
active View.

[Peak] Designates how the peak value or peak position of the
active spectrum should be displayed when the [Peak
Find...] command is executed.

2.3.1  [Scale...]

Select [View] - [Scale...] to display the [Scale] dialog box used to change the scale of
the spectrum/spectra displayed in the active View.
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Fig. 2.12  [Scale] dialog box

Horizontal scale Enter the desired start and end values of the horizontal
scale in the text boxes at the bottom of the preview pane.
When [Auto] is checked, the input values are ignored and
all regions are displayed.

Vertical scale Enter the desired start and end values of the vertical in
the text boxes at the left of the preview pane. When
[Auto] is checked, the input values are ignored and the
most appropriate scale for the designated horizontal
range is displayed.

2.3.2  [Pattern...]

Select [View] - [Pattern...] to display the [Pattern Settings] dialog box used to select
the line style and color of the spectrum/spectra displayed in the active View.

Fig. 2.13  [Pattern Settings] dialog box

[Element] Lists items for which the color or line style can be
changed.

[Color] Shows available colors. Select desired color from this
palette. The currently designated item in the [Element]
list is displayed in the selected color.

[Line Style] Shows available line styles. The currently designated
item in the [Element] list is displayed with the selected
line style.

[Line Width] Shows available line widths. The currently designated
item in the [Element] list is displayed with the selected
line width.

[Sample] Displays a sample of the designated pattern.
[As Default] Check to use the designated pattern for all subsequently

opened views.
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2.3.3  [Font...]

Select [View] - [Font...] to display the [Font] dialog box used to select the font settings
and orientation for the active View.

Fig. 2.14  [Font] dialog box

[Item] Lists the items for which the font settings can be
changed. The font settings for the axis label, scale
label, and peak mark can all be changed.

<Setting...> Click to change the font settings for the currentl
designated [Item].

[Vertical Label Orientation]
group

Sets the label orientation for the vertical axis.

[Peak Mark Orientation] group Sets the label orientation for the peak mark.
[As Default] Check to use the designated font settings for all

subsequently opened views.

2.3.4  [Grid...]

Select [View] - [Grid] to display the [Grid lines] dialog box used to add/remove vertical
and/or horizontal lines to the active View.

Fig. 2.15  [Grid Lines] dialog box

[Main] group
[Horizontal Axis] Check to display main horizontal axis lines.
[Vertical Axis] Check to display main vertical axis lines.

[Auxiliary] group
[Horizontal Axis] Check to display auxiliary horizontal axis lines.
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[Vertical Axis] Check to display auxiliary vertical axis lines.
[As Default] Check to use the current grid lines for all subsequently

opened views.

Note: When the [Apply view setting to all spectra] check box in the [Customize]
dialog box is checked, the grid lines settings are applied to all Views.

2.3.5  [Style...]

Select [View] - [Style...] to display the [Scale Setting] dialog box used to change the
scale settings for the active View.

Fig. 2.16  [Style Setting] dialog box

[Axis] Lists the available formats for the
horizontal and vertical axis.

[Interval] group
[Auto] Select the [Auto] option button to

automatically designate the grid
format.

[Manual] Select the [Manual] option button to
manually set the grid format of the
main and auxiliary scale.

[Decimal Point on scale
label]

Designates the number of decimal
places for the horizontal and vertical
axis display values.

[As Default] Check to use the current scale
settings for all subsequently opened
views.

2.3.6  [Horizontal Axis...]

Select [View] - [Horizontal Axis...] to display the [Horizontal Axis] dialog box used to
change the horizontal axis.
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Fig. 2.17  [Horizontal Axis] dialog box

[Axis List] Lists the available formats for the horizontal axis.

2.3.7  [Information...]

Displays spectrum information for the currently selected spectrum in the active View.

Fig 2.18  [Spectrum Information] dialog box

2.3.8  [Normalize]

Automatically normalizes the scale of each spectrum displayed in the active View.
The purpose of this function is so that spectra with different vertical axis scales can
be viewed at the same time in a single View window. When the [Normalize] function
is active, a box appears around the vertical axis label in the active View.
For example, for two spectra displayed in %T mode and Abs mode, the spectrum
displayed in Abs mode is not visible as shown in Fig. 2.19.

Fig 2.19  Overlay - View
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By switching to [Normalize] both spectra are visible as shown in Fig. 2.20.

Fig 2.20  Normalize - View

2.3.9  [Peak]

Click [View] - [Peak] to display a submenu in which you can designate how the peak
value or peak position of the active spectrum should be displayed when the [Peak
Find...] command is executed.

[None] Peak position not displayed.
[Bar] Denotes peak position with a vertical bar.
[Bar, Data No.] Denotes peak position with a vertical bar, and displays

the peak number.
[Bar, X] Denotes peak position with a vertical bar, and displays

the horizontal axis value.
[Bar, Y] Denotes the peak position with a vertical bar, and

displays the vertical axis value.
[Bar, X, Y] Denotes the peak position with a vertical bar, and

displays the horizontal and vertical axis values.

2.3.10 ［Legend display switcing］

Switches over the legend display of active view spectrum in the spectral analysis

window.  A legend is displayed in the tool bar if the tool button  is not clicked (see

Fig. 2.24 (a)). Clicking the tool button  displays a legend on the status bar (see
Fig. 2.24 (b)).  In addition to the filename are displayed measurement date, sample
name, operator’s name, organization and comment.  O before the filename is green if

the spectrum is saved or red if not.  before the filename is green if the spectrum is
saved or red if not.

Fig. 2.24 (a)  Display of legend on tool bar
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Fig. 2.24 (b)  Display of legend on status bar

Double-clicking the legend filename displayed on the status bar allows the spectrum
to be saved by assigning a name to it.  Double-clicking the measurement date
displays spectrum information, and double-clicking the sample name, operator’s
name, organization or comment opens the comment edit dialog, allowing the sample
name, operator’s name, organization and comment to be edited.
Spectra can be overlaid in an active view by double-clicking a location where legend
is not displayed.
Also right-clicking each legend displays the menu for save, save as, delete spectrum,
spectrum information or edit comment.

Right-clicking a location where legend is not displayed displays the menu for
overwrite, print, or print preview.
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2.4  [Processing] Menu

This section describes the commands contained in the [Processing] menu.

[Correction] submenu
[Baseline...] Displays the [Baseline Correction] dialog box used

for correcting a spectrum using a free baseline.
[Smoothing...] Displays the [Smoothing] dialog box used to

smooth spectrum data.
[Noise Elimination...] Displays the [Noise Elimination] dialog box used to

eliminate pseudo-peak(s) caused by noise or
some other known cause.

[Deconvolution...] Displays the [Deconvolution] dialog box used to
analyze bands that may contain overlapping
Lorentzian curves having the same FWHM values
and accurately distinguishes the peak positions for
each band.

[FFT filter...] Displays the [FFT Filter] dialog box used to
separate a spectrum into frequency components
using a Fast Fourier Transformation. Eliminates
noise having a particular periodicity.

[Data Cut...] Displays the [Approximate and Data Cut] dialog
box used to create a spectrum with an arbitrary
data interval in an arbitrary wavelength region.
Data in any wavenumber region can also be cut
without changing the data.

[Operation] submenu
[Arithmetic...] Displays the [Arithmetic] dialog box used to

perform arithmetic operations between spectra or
between a spectrum and a constant.

[Derivatives...] Displays the [Derivatives] dialog box used to
obtain the 1st, 2nd or 3rd order derivative of a
spectrum.

[KK conversion...] Displays the [KK Conversion] dialog box used to
correct the specular reflection spectrum (Kramers-
Kronig conversion).

[Peak Process]
 submenu
[Peak Find...] Displays the [Peak Find] dialog box used to find

spectrum peaks and/or valleys.
[Peak Height...] Displays the [Peak Height] dialog box used to

determine peak height and height ratio.
[Peak Area...] Displays the [Peak Area] dialog box used to

determine peak area and area ratio.
[Peak Width...] Displays the [Peak Width] dialog box used to

calculate the full width at half maximum value.
[Subtraction...] Displays the [Subtraction] dialog box used to

determine a difference spectrum.
[X Unit Conversion...] Displays the [X Unit Conversion] dialog box used
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to convert the X-axis units of the active spectrum.
[Y Unit Conversion...] Displays the [Y Unit Conversion] dialog box used

to convert the Y-axis units of the active spectrum.

[Other...] submenu
[Comment...] Displays the [Comment Edit] dialog box used to

add or edit comments.

[Common Options]
submenu
[Kinetics...] Displays the [Kinetics] dialog box used to

calculate an enzyme activity value.
[Data Dump…] Displays the [Data Dump Parameter] dialog box

used to display measured data values and copy
them to the clipboard.

[Arithmetic with Data...] Performs arithmetic operations using data overlaid
in the same channel of a view.

[Arithmetic with Channel...] Performs arithmetic operations using data freely
selected from multiple channels of data displayed
in a view.

[Move Channel…] Moves channels in a view or picks up only data of
a desired channel from data overlaid in a view or
from multiple-channel data.

Data Accumulation Accumulates the data overlaid in the same
channel of a View and displays the accumulated
data in a new View.

[CD Options] submenu
[HT -> OD…] Converts HT voltage data to absorbance.
[Optical Constant…] Calculates optical constants.
[KK Conversion…] Converts CD data to ORD or ORD data to CD.
[G-value…] Calculates the G value which represents the

degree of asymmetry of the absorption band.
[pH conversion] Opens a new view with CD value (or fluorescence,

HT or other) displayed on the vertical axis and pH
data on the horizontal axis

[FP Options] submenu
[Phospho. Lifetime...] Displays the [Phosphorescent Lifetime Analysis]

dialog box used to calculate phosphorescent
lifetime.

[IR Options] submenu
[ATR conversion…] Converts the absorption intensity relationship

between the high wavenumber side and low
wavenumber side.

[IF to spectrum…] Converts an intrferogram(IF) into a single-beam
spectrum.

[Spectrum to IF…] Converts a single-beam spectrum into an
interferogram(IF).



23

2.4.1  [Correction] submenu

2.4.1.1  [Baseline...]

Select [Processing] - [Correction] - [Baseline...] to correct the active spectrum using a
free baseline. A baseline with a maximum of 32 variable points (including both ends)
can be created. The variable points can be connected with a straight line or a spline
curve.

Fig. 2.21  [Baseline Correction] dialog box

Baseline drop-down list
[Line] Select to connect adjacent variable points with a

straight line.
[Spline] Select to connect adjacent variable points with a

spline curve.
<Reset> Click to restore the baseline to its original shape (i.e.

two variable points connected with a straight line).
<Erase> Click to erase a single variable point. Darkened

points or points with thick square frames can be
erased. If a variable point on the left or right end is
erased, the next point becomes the end point.

Spectrum display area Set the spectrum baseline in the upper spectrum to
display the results below. Move the small squares on
the baseline (initially only at the ends) to change the
baseline shape. When the pointer approaches a
square, the shape of the pointer changes to a set of
tweezers that can be used to drag the square to
another location.
When the pointer approaches the baseline, the
shape of the pointer changes to a syringe. Click the
left mouse button to add variable points.

2.4.1.2  [Smoothing...]

Select [Processing] - [Correction] - [Smoothing...] to smooth the active spectrum.
The following four methods are available: Means-Movement, Savitzky-Golay,
Adaptive-Smoothing and Binomial.
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Fig. 2.22  [Smoothing] dialog box

[Method] drop-down
list

Lists available smoothing methods.

[Convolution Width] Sets the number of data points to be bundled on both
sides for each data point. Only odd numbers can be
set. Values are immediately recalculated after each
change.

<Apply> Applies the set convolution width value, and then
calculates.

Spectrum display area The original spectrum is displayed at the top, the
smoothed spectrum below.

<Scale...> Click to set the spectrum range.
[Y-axis Auto Scale] Check this box to view the results using the auto

scale function. Deselect when viewing the change in
the size of the differential spectrum.

Note: Refer to “Smoothing Method” in the Appendix for details of each method.

2.4.1.3  [Noise Elimination...]

Select [Processing] - [Correction] - [Noise Elimination...] to eliminate false peaks due
to noise of known origin. The peak is eliminated by connecting the designated
horizontal axis ranges with a straight line. The horizontal axis range can also be
changed.

Fig. 2.23  [Noise Elimination] dialog box
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Wavelength display Displays the position of the active wavelength axis
setting bar. Input a wavelength, and then click
<Apply> to shift the active wavelength setting bar to
the designated position.

<Apply> Moves the active wavelength setting bar to the
designated position.

<Execute> Executes noise elimination.
<Reset> Resets the spectrum to its original condition before

noise elimination.
Spectrum display area The original spectrum is displayed at the top, and the

spectrum with noise removed below.
<Scale...> Click to set the spectrum range.

[Y-axis Auto Scale] Check this box to view the results using the auto
scale function. Deselect when viewing the change in
the size of the differential spectrum.

2.4.1.4  [Deconvolution...]

This function analyzes bands that may contain overlapping Lorentzian curves having
the same full width at half maximum value and accurately distinguishes the peak
positions for each band.

Note: The region outside the wavelength range of interest will also be influenced by
the deconvolution calculation, and the spectral profile will change.

Fig. 2.24  [Deconvolution] dialog Box

Note: Figure 2.24 shows spectra before execution of deconvolution, therefore, the
upper and lower spectra in the spectrum display area are the same. After
execution, the resulting spectrum is displayed in the lower half of the
spectrum display area.

[FWHM] Specify the full width at half maximum value of the
expected Lorenz waveform.

<Apply> Click to perform deconvolution using the input value.
<Scale...> Click to set the spectrum range.
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[Y-axis Auto Scale] Check this box to view the results using the auto scale
function. Deselect when viewing the change in the size
of the differential spectrum.

Fig 2.25  [Deconvolution] result screen (example)

Note: Before clicking <OK> and confirming the changes, you can execute
deconvolution with different full width at half maximum values as many times
as you wish. The results are displayed in the lower half of the spectrum
display area. For more details on deconvolution refer to the Appendix.

2.4.1.5  [FFT filter...]

Separates the spectrum into frequency components using a Fast Fourier
transformation and eliminates noise having a particular periodicity. A filter containing
a maximum of 32 variable points (including both ends) can be created. However, if
the peaks and noise are almost the same height, the noise cannot be removed.

Fig. 2.26  [FFT filter] dialog box

Note: Figure 2.26 shows spectra before execution of FFT filter, therefore, the upper
and lower spectra in the spectrum display area are the same. After
execution, the resulting spectrum is displayed in the lower half of the
spectrum display area.
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Spectrum display area Set the shape of the FFT filter in the upper spectrum
and the results are displayed below. Move the small
squares on the filter (initially only at the ends) to
change the shape. When the pointer approaches a
square, the shape of the pointer changes to a set of
tweezers that can be used to drag the square to
another location.
When the pointer approaches the filter, the shape of
the pointer changes to a syringe. Click the left mouse
button to add variable points. The X and Y values at
the left correspond to the coordinates of the variable
point and the period to the period of noise (nm).

<Erase> Click to erase a single variable point. Darkened points
or points with thick square frames can be erased. If a
variable point on the left or right end is erased, the
next point becomes the end point.
The minimum number of variable points is two. If only
two points exist, neither can be erased.

<Reset> Returns the filter to its original shape.
<Apply> Click to perform calculation with the set filter. The

resulting spectrum is displayed in the lower half of the
spectrum display area.

2.4.1.6  [Data Cut...]

Creates a spectrum with an arbitrary data interval in an arbitrary region of the X-axis.
Data in any region of the X-axis can also be cut without changing the data.

Fig 2.27  [Approximate and Data Cut] dialog box

Note: Figure 2.27 shows spectra before execution of data interpolation and cut,
therefore, the upper and lower spectra in the spectrum display area are the
same. After execution, the resulting spectrum is displayed in the lower half of
the spectrum display area.

Spectrum display area The original spectrum is displayed at the top, and the
spectrum with noise removed below.

[Method] drop-down list Select the method of data interpolation. The
following options are available (see reference
section below):
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[Lagrange] Lagrangian interpolation
[3rd order spline] Tertiary spline

 interpolation
[No correction] Select this when cutting

data.
[Data pitch] Specify the pitch of the data to be created.
[X-Axis (L)] Specify the lower X-axis value of the data to be

created.
[X-Axis (R)] Specify the upper X-axis value of the data to be

created.
<Apply> Click to execute data interpolation and cut using the

entered values.
<Data Detail> Click to display information for the original spectrum.

Note: The resulting spectrum data can be saved in text file format to be utilized in
other applications.

Reference: Methods of data interpolation
Data interpolation determines the interpolation function, F that satisfies Yi = (Xi);
i=1,2,3,... N from the data points {(Xi,Yi); i=1,2,3,...N} obtained by measurement in
order to estimate Y with respect to X (except for known Xi).
“Lagrange interpolation” and “Tertiary spline interpolation” are representative
methods of data interpolation.
(1) Lagrange interpolation
This method determines a function F that passes all data points in a specified range
for interpolation. For N data points, the interpolation function F is basically an (N - 1)th

function, thus making it complicated. However, in practice, calculation is made by
making some contrivances.
(2) Tertiary spline interpolation
This method calculates the values between N data points within a specified range by
using (N - 1) items of different tertiary functions Fi. The interpolation functions Fi and
Fi+1 of adjacent sections are determined so that the value of the function and the
primary and secondary derivative factors at the boundary point agree with each other.

2.4.2  [Operation] submenu

2.4.2.1  [Arithmetic...]

Select [Processing] - [Operation] - [Arithmetic...] to perform an arithmetic operation
between spectra or between a spectrum and a constant(s). When only one spectrum
is displayed in the active view, the arithmetic operation is performed using a
constant(s). When two or more spectra are displayed, the arithmetic operation is
performed between the spectra. When three or more spectra are displayed, The
spectra used for arithmetic operation must be designated from the [Select Spectrum]
dialog box which opens before the [Arithmetic] dialog box.
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Fig. 2.28  [Select Spectrum] dialog box

Fig. 2.29  [Arithmetic] dialog box (when two spectra are displayed)

The operation to be performed is shown at the top of the dialog box. S1 and S2
represent the selected spectra and are defined below. Enter constants into the
appropriate text boxes and select the desired arithmetic operator from the drop-down
list to generate an arithmetic expression.

<Apply> Click to execute calculation using the designated
parameters.

<Exchange> Reverses the positions of spectra S1 and S2.
Spectrum display area The original spectrum or spectra is (are) displayed at

the top, the results of the arithmetic operation below.
<Scale...> Click to set the spectrum range.

[Y-axis Auto Scale] Check this box to view the results using the auto scale
function. Deselect when viewing the change in the size
of the differential spectrum.

Note: To perform arithmetic operation between one spectrum and a constant in a
view in which multiple spectra are displayed, open the dialog according to
the same procedure as when performing an arithmetic operation between
two spectra. Input 0 for the factor and a constant not related to the operation.

Note: The result of dividing between single beams (SB) is converted to %T. When
adding or subtracting %T (%R), the values are added or subtracted in the
same units. (Addition of 100% and 100% makes 200% and subtraction
becomes 0%. (This is in contrast to the difference spectrum obtained using
“difference by conversion to ABS.”)
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2.4.2.2  [Derivatives...]

Select [Processing] - [Operation] - [Derivatives...] to determine the derivative of a
spectrum. First-, second-, and third-order derivative calculations can be performed.
Differentiates spectrum.  Can be selected from [Subtract] and [Savitzky-Golay
method].

Fig. 2.30  [Derivatives] dialog box

[Algorithm] Selects the derivative system from the drop-down list.
[Order of Derivatives] Select the order of the derivative.
[Order of Polynomial] Selects the order of polynomial by [Savitzky-Golay

method].
[Data Points] Selects the interval between data points.

Note: In the derivatives of a spectrum containing high noise, it is recommended to
conduct smoothing first or use a higher number of [Data Points].

2.4.2.3  [KK Conversion...]

This function is used to determine the absorbance from a specular reflection
spectrum (Kramers-Kronig conversion). Only available for spectra for which the
vertical axis is absorbance (Abs), %T or %R.
Since the specular reflection spectrum is affected by the refractive index and
absorption of the sample, the spectrum is measured using a derivative profile. The
derivative profile can be divided into two components: an absorption index(k) and a
refractive index(n), by subjecting it to Kramers-Kronig conversion. This processing
can be used effectively for a spectrum with a derivative profile and for which both
ends are flat. In addition, when applying Kramers Kronig conversion to only a specific
region, select a region for which both ends are flat.
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Fig 2.31  [KK Conversion] dialog box

Note: Figure 2.31 shows spectra before execution of KK conversion, therefore, all
three spectra in the spectrum display area are the same. After execution, the
top spectrum is the original spectrum, the middle spectrum is the KK-
converted spectrum and the bottom spectrum is the refractive index
spectrum obtained through calculation.

Spectrum display area The top spectrum is the original spectrum, the
middle spectrum is the KK-converted spectrum and
the bottom spectrum is the refractive index spectrum
obtained through calculation.

[Thinning] Designates the interval between data points to be
used for calculation. Calculation is faster when this
value is large.

<Apply> Click to execute calculation using the set
parameters. The KK-converted spectrum is in Abs
mode.

<OK> Click to close the dialog box. Two Views containing
the absorption index(k) spectrum and refractive
index(n) spectrum are displayed.

Fig 2.32  [KK Conversion] result dialog box
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2.4.3  [Peak Process] submenu

2.4.3.1  [Peak Find...]

Select [Processing] - [Peak Process] - [Peak Find...] to display the [Peak Find] dialog
box used to detect spectrum peaks/valleys. A maximum of 100 peaks/valleys can be
detected for each spectrum.

Fig. 2.33  [Peak Find] dialog box

[Peak] drop-down list Lists available modes for detecting peaks/valleys.
Top: Detects peaks.
Bottom: Detects valleys.
Both: Detects both peaks and valleys.

[Noise Level] Enter a threshold value used to recognize a peak/valley.
When the difference between the start of a peak/valley to
its apex does not meet or exceed this value, the peak will
not be recognized. The units are the same as those used
in the active spectrum.

[Enable Lower and
Upper Limit]

When this box is checked the peak find function searches

the portion of the spectrum currently displayed in the dialog

box, in other words, within the limits of the x- and y-axes.

Therefore, by changing the scale settings it is possible to

search within a specific region of the measured spectrum.
When this box is unchecked the peak find function
searches the portion of the spectrum contained within the
limits of the current x-axis and ignores the limits of the y-
axis.

<Peak table> Click to display a table of the previous peak find results for the
active spectrum. This display is the same as that which
appears when <Execute> is clicked and peaks/valleys are
found.

<Execute> Click to find peaks and/or valleys. The dialog box closes
and the results of the search are displayed.

The following explains the components of the [Peak Find] results dialog box.
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Fig. 2.34  [Peak Find] results dialog box

Peak list Displays the peak find results for the active spectrum.
Clicking on a value causes a vertical line to appear at the
selected peak/valley position in the spectrum display area
below. The peak/valley position and intensity are
displayed as X- and Y-axis values, respectively, in the box
to the left.

Spectrum display area By clicking on the short bar that indicates a peak position,
the long bar will move to that position. The selected value
in the peak list becomes highlighted. This operation is the
same as clicking on a value in the peak list.
The long bar can also be moved to locations other than
peak/valley positions by clicking the desired position in
the spectrum. The wavelength and Abs for the position
appear against the X- and Y-axis, respectively, in the box
to the left. To add a peak, click on the desired peak
position, and then click <Add>.

<Add> Click to add a peak. Click <Add> after clicking on the
desired position.

<Delete> Click to delete a peak. Select the peaks to be deleted in
the peak list or in the spectrum display, and then click.

<Retry> Click to stop operation and return to the previous dialog
box.

<Print> Click to open the [Print] dialog box. For details refer to
Section 2.1.7.

2.4.3.2  [Peak Height...]

This function detects the peak height and calculates the height ratio. Two methods
are available for finding the peak height.
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Peak height

Baseline

(1) 2 Point base: Designate 2 points
      to determine the baseline

Peak height

Baseline

(2) 1 Point base: Designate 1 point to 
      determine the baseline

Designate these points Designate this point

Fig. 2.35  Methods for finding peak height

The [Peak Height] dialog box contains parameters for detecting the peak height and
calculating the height ratio. Since the [Peak Height] dialog box contains many
elements, before explaining each element in the dialog box the procedure for
calculating peak height is described below.
The following example explains how to automatically detect a peak using the [2-Point
Base] method.
(1) Select [Processing] - [Peak Process] - [Peak Height...] to display the following

dialog box.

Result display field
[P1, P2]
Check box Wavelength setting field Information display field

[Peak], [Base 1], [Base 2]

Spectrum display field

Fig. 2.36  [Peak Height] dialog box
(2) Check the [P1] checkbox to calculate the peak height.

Note: [P2] should also be selected when calculating the peak height ratio.

(3) Click <Setting...> to open the [Peak Height - Set] dialog box. Set the peak height
detecting parameters as follows.
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Parameter display
field

Fig. 2.37  [Peak Height - Set] dialog box

(a) Click on [P1] in the parameter display field to set the parameters for [P1].
(b) Select the [2 Point Base] option button in the [Baseline] group.
(c) Select the [Auto] option button in the [Peak Pos.] group.

Note: When calculating the peak ratio, repeat steps 3a) to 3c) replacing [P1] for
[P2] to set the parameters for [P2].

Click <OK> to close the [Peak Height - Set] dialog box.
(4) Set the base wavelength for Peak 1 as follows.

(a) Click on the row of numbers to the right of [P1] in the information display. The
wavelengths of peak [P1] and the base position are displayed in the
wavelength setting fields, allowing the wavelength to be changed.

(b) Set the base wavelength using the wavelength setting bar on the spectrum.
The wavelength can also be set by directly inputting a value into the text box,
and then clicking <Apply>. Peak height is calculated and displayed in the
result display field.

Note: When calculating peak ratio, set the wavelength for Peak 2 using the same
procedure.

(5) Click [Print] to open the [Print] dialog box. Click <OK> to print the results.

[Peak Height] dialog box

Result display field: When the [P1] and [P2] checkboxes are selected, the
heights of P1 and P2 are displayed at [P1] and [P2],
respectively, and the height ratios of Peak 1/Peak 2 and
Peak 2/Peak 1 are displayed at [P2/P2] and [P2/P1],
respectively. The results are recalculated and
redisplayed each time the peak and base wavelength
are changed.

[P1], [P2] Check these boxes to display the calculation results in
the Result display fields.

[Peak], [Base 1],
[Base 2]

Wavelength setting fields for Peak 1, Base 1 and Base
2.

Information display
field:

Displays the peaks and base wavelength of [P1] and
[P2] for calculating the peak height/height ratio. Click the
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wavelength setting box to change the wavelength using
the wavelength setting bar.

Spectrum display area Set the peak or base wavelength by dragging the
wavelength setting bar on the spectrum. The peak
height/height ratio is calculated at the same time as it is
set. The data of the active wavelength setting bar
appears at the upper-right side of the display beside
[Data].

<Apply> After entering the Peak, Base 1 and Base 2 values, click
<Apply> to move the wavelength setting bar to the
designated wavelengths and execute calculation.

<OK> Closes the dialog box and stores the peak height
information in memory.

<Print> Opens the [Print] dialog box. For details refer to Section
2.1.7.

<Setting...> Click to open the parameter setting dialog box for
calculating the peak height and peak height ratio.

[Peak Height-set] dialog box

Parameter display field: Displays the [P1] and [P2] calculation parameters.
Click on [P1] to set the parameters for [P1]. Similarly,
for [P2].

[Baseline] group Contains the available baseline drawing methods.
[2 Point Base] Draws baseline by designating two points.
[1 Point Base] Draws baseline in the horizontal direction by

designating one point as a reference.
[Peak Pos.] group Select either [Auto] detection or [Manual] setting of

peak position. For [2 Point Base], [Auto] setting
recognizes the position where absorption is highest
as the peak within the range designated by Base 1
and Base 2. For [1 Point Base], [Auto] cannot be
designated.

<OK> Closes the dialog box and returns to the [Peak
Height] dialog box.

2.4.3.3  [Peak Area...]

This function determines the peak area and calculates the area ratio. Three methods
are available for determining the peak area:

(1) [2 Point Base] Determines total area within baseline
(2) [No Base] Assumes 0 or 100% as the baseline
(3) [Arbitrary Base] Sets the baseline and peak ranges separately
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Peak height

Baseline

(1) Determines total area
     within baseline Peak area

Peak height

Baseline

(2) Assumes 0 or 100% as    
     the baseline Peak area

Peak height

Baseline

(3) Sets the baseline and peak 
     ranges separately

Designate these points Designate these points Designate these points

Fig. 2.38  Peak Area detection methods
In addition, three methods are available for calculating the peak area:
(1) Ignore Under Baseline Region
(2) Subtract Under Baseline Region
(3) Add Under Baseline Region
To calculate peak area +  in Fig. 2.39, designate a [2 Point Base] from Point A to
Point B and select [Add Under Baseline Region]. To calculate peak area ,
designate a [2 Point Base] from Point A to Point B and select [Ignore Under Baseline
Region]. To calculate peak area - , designate a [2 Point Base] from Point A to
Point B and select [Subtract Under Baseline Region].
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          Fig. 2.39 Example 1 Fig. 2.40 Example 2

In Fig. 2.40, when a baseline is designated from point A to B, all three methods give
the same result.
The [Peak Area] dialog box contains parameters used to calculate the peak area and
the area ratio. Since [Peak Area] dialog box contains many elements, before
explaining each element in the dialog box the procedure for calculating peak area is
described below.
The following example explains how to calculate peak area using the [2-Point Base]
method.

(1) Select [Processing] - [Peak Process] - [Peak Area...] to display the following
dialog box.
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Result display field
[P1], [P2]
Check box Wavelength setting field Information display field

Spectrum display field

Fig. 2.41  [Peak Area] dialog box

(2) Check the [P1] box to calculate peak area.

Note: [P2] should also be selected when calculating the peak area ratio.
(3) Click <Setting...> to open the [Peak Area - Set] dialog box. Set the peak area

calculation method as follows.

Parameter display field

Fig. 2.42  [Peak Area - Set] dialog box

(a) Click on [P1] in the parameter display field to set parameters for [P1].
(b) Select the [2 Point Base] option button in the [Baseline] group.

Note: When calculating peak area ratio, repeat steps 3a) and 3b) replacing [P1]
with [P2] to set the parameters for [P2].

(4) Set the base wavelength for Peak 1
(a) Click on [P1] in the information display field. The wavelength at the base

position is displayed in [Range(Baseline)] allowing the wavelength to be
changed.

(b) Set the base wavelength using the wavelength setting bar on the spectrum.
The wavelength can also be set by directly inputting a value into the text box,
and then clicking <Apply>. Peak area is calculated and displayed in the results
display field.
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Note: Set the wavelength for [P2] using the same procedure when calculating peak
area ratio.

(5) Click <Print> to open the [Print] dialog box. Click <OK> to print the results.
[Peak Area] dialog box

Results display field: When the [P1]/[P2] checkboxes are selected, the areas
for Peak 1 and Peak 2 are displayed at [P1] and [P2],
respectively, and the area ratios of Peak 1/Peak 2 and
Peak 2/Peak 1 are displayed at [P1/P2] and [P2/P1],
respectively. The results are recalculated and
redisplayed each time the wavelengths of the area
calculating range and base calculating range are
changed.

[P1], [P2] When these checkboxes are selected, the results are
displayed in the results display field.

[Range (Area)],
[Range (Baseline)]

These are wavelength ranges for calculating area and
drawing the baseline, respectively. Click on and drag the
wavelength setting bar to the desired location, or input
the values directly. For [2 Point Base], set the
wavelength in [Range (Baseline)]. For [No Base], set the
wavelength in [Range (Area)]. For [Arbitrary Base], set
the wavelength range for drawing the baseline in [Range
(Baseline)], and for calculating peak area, set the
wavelength in [Range (Area)].

Information display
box:

Displays the wavelengths set in [Range (Area)] and
[Range (Baseline)] for peak [P1] and [P2] for calculating
the peak height/height ratio. Click the wavelength setting
box to change the wavelength using the wavelength
setting bar.

Spectrum field: Set the peak and base wavelengths by dragging the
wavelength setting bar on the spectrum. The peak
area/area ratio is calculated at the same time as it is set.
Data from the active wavelength setting bar are
displayed at upper-right side of the display beside [Data].

<Apply> After entering the [Range (Area)] and [range (Baseline)],
click <Apply> to move the wavelength setting bar to the
designated wavelengths and execute calculation.

<OK> Closes the dialog box and stores the peak area
information in memory.

<Print> Opens the [Print] dialog box. For details refer to Section
2.1.7.

<Setting...> Opens the [Peak Area - Set] dialog box.

[Peak Area - Set] dialog box

Parameter display field: Displays the [P1] and [P2] calculation parameters.
Click on [P1] to set the parameters for [P1]. Similarly,
for [P2].

[Baseline] group Contains the available baseline drawing methods.
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[2 Point base] Designates two points to determine the area within the
baseline range.

[No Base] Designates two points to calculate the area from the
zero line.

[Arbitrary Base] Calculates area by designating the wavelength ranges
for drawing the baseline and for area calculation
separately.

[Calculation] group Select area calculation method from the following
three methods. (Refer to Fig. 2.39 and Fig. 40)

[Ignore Under Baseline Region]
[Subtract Under Baseline Region]
[Add Under baseline Region]

<OK> Closes the dialog box and returns to the [Peak Area]
dialog box.

2.4.3.4  [Peak Width...]

Select [Processing] - [Peak Process] - [Peak Width...] to display the [FWHM] dialog
box used to calculate the full width at half maximum.

Fig. 2.43  [FWHM] dialog box

Spectrum area: Set the full width at half maximum calculating range by
dragging the wavelength setting bar on the spectrum.
The full width at half maximum value is calculated
simultaneously.

In addition to the wavelength setting bar, the full width at half maximum
calculation range can be entered directly in [Xaxis(R)] and [Xaxis(L)].

[Xaxis(R)] Enter the lower X-axis value for the full width at half
maximum calculation range.

[Xaxis(L)] Enter the upper X-axis value for the full width at half
maximum calculation range.

[FWHM] Displays the result of the full width at half maximum
calculation.

<Print> Opens the [Print] dialog box. For details refer to Section
2.1.7.
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2.4.4  [Subtraction...]

Select [Processing] - [Subtraction...] to determine a difference spectrum.
One method of identifying an unknown sample is to compare the spectrum of the sample
with other known spectra. To identify the components of an unknown mixture, the
spectrum of the known components can be removed, leaving only the spectrum of the
unknown components of the mixture. Thus, if the spectrum of the mixture is assumed to
be A, and the spectrum of known components is assumed to be B, the difference
spectrum can be determined using the formula (A × coefficient - B) or the formula (A - B ×
coefficient). The coefficient should be set to cancel the intensity of a common absorption
peak (key band).
The coefficient can be applied using one of two methods. The first method involves
continuously changing the coefficient to remove the key band by trial and error while
viewing the spectrum. The second method involves calculating a coefficient from an
observed peak height or area in order to remove the key band.
The number of spectra overlaid in the view determines which dialog box opens first
when [Subtraction...] is executed.

• When one spectrum is displayed, the file [Open] dialog box appears. Select
a spectrum to be used for subtraction.

• When two spectra are displayed, the [Subtraction] dialog box appears.
• When three or more spectra are displayed, the [Select Spectrum] dialog

box appears. Select a spectrum to be used for subtraction.

Fig. 2.44  [Subtraction] dialog box

In Fig. 2.44, the resulting difference spectrum of Coefficient × Memory#2 - Memory#4
appears in the lower half of the spectrum display area.

[Factor] Input a factor. The factor can also be changed using the
arrow keys . Each click on an arrow key  increases
or decreases the factor by the amount designated in
[Step]. The difference spectrum is recalculated each time
the factor is changed.

[Step] Designates the increment or decrement by which [Factor]
increases or decreases each time an arrow key  is
clicked.

<Switch> Exchanges the spectrum to be multiplied by the factor. In
the above figure, clicking <Switch> will change the
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calculation from Factor × Memory#2 – Memory#4 to
Memory#2 – Factor × Memory#4.

Spectrum display area The spectra are displayed at the top and the difference
spectrum below.

[Spectrum] group
<Scale...> Click to set the spectrum range.
<Offset...> Click to open the [Subtraction (Offset)] dialog box used to

calculate the entire spectrum based on the assumption
that the difference between two spectra on a designated
horizontal axis is zero.

Fig. 2.45  [Subtraction [Offset]] dialog box

When the offset box is checked, calculation is performed
based on the assumption that the difference at the
horizontal axis designated in [X-axis] is zero.

<Exchange> Click to exchange spectra. In Fig. 2.44, clicking
<Exhange> will change the calculation from Factor ×
Memory#2 – Memory#4 to Factor × Memory#4 -
Memory#2.

<Set Base Peak...> Click to display the [Subtraction (Set Base Peak)] dialog
box used to calculate the factors that offset a particular
peak. These factors can be calculated for peak height or
area. (The contents of the [Subtraction [Set Base Peak] ]
dialog box are described below.)

[Y-axis Auto Scale] Check this box to view the results using the auto scale
function. Deselect when viewing the change in the size of
the differential spectrum.

Fig. 2.46  [Subtraction [Set Base Peak]] dialog box

Subtraction [Set Base Peak] dialog box
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<Setting...> When determining the factor using the peak height, the
following two baseline drawing methods are available.

Peak height

Baseline

Designate thesepoints  

Peak height

Baseline

Designate this point

(1) 2-Point base: Designate 2 points to
determine the baseline

(2) 1-Point base: Designate 1 point to
determine the baseline

Fig. 2.47  Baseline drawing methods when determining factor using peak height

When determining the factor using the peak area, the
following two methods are available.
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(3) 2-Point base:Determines the zero-

level by designating the
range.

(4) No base: Calculates area from area
within baseline.

Fig. 2.48 Baseline drawing methods when determining factor using peak area

To designate the appropriate method, click <Setting...>
and change the parameters in the [Set peak
Parameters] dialog box displayed.

Fig. 2.49  [Set Peak Parameters] dialog box

[Range (Peak)] Wavelength or wavelength range for calculating peak
height or area. Click on and drag the wavelength setting
bar to the desired location, or input the values directly.
For method (1), input peak wavelength.
For method (4), input area calculating range.
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[Range (Baseline)] Wavelength range for drawing baseline.
For methods (1) and (4), input the range of the baseline.

<Apply> Calculates the factor at the designated horizontal axis
value. (When the horizontal axis value is set using the
wavelength setting bar, calculation is performed
automatically and clicking on <Apply> is not necessary.)

[Data] Displays the data of the active spectrum at the position
of the moving wavelength setting bar. (The spectrum
displayed in the small box to the right of <Exchange> is
the active spectrum.)

<Exchange> Click to change the active spectrum. Each click on this
button changes the spectrum displayed at right.

2.4.5  [X Unit Conversion...]

Select [Processing] - [X Unit Conversion...] to display the [X-axis Conversion] dialog
box used to convert the X-axis units of the spectrum.

Fig. 2.50  [X-axis Conversion] dialog box

2.4.6  [Y Unit Conversion...]

Select [Processing] - [Y Unit Conversion...] to display the [Y Unit Conversion] dialog
box used to convert the Y-axis units of the spectrum.
This function is applicable for spectra for which the vertical axis is
absorbance(Abs), %T or %R.

Note: When a spectrum is selected for which the vertical axis is intensity a [Data
mode error ] message will appear.

Fig. 2.51  [Y Unit Conversion] dialog box
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2.4.7  [Other...]

2.4.7.1  [Comment...]

Select [Processing] - [Other...] - [Comment...] to display the [Comment Edit] dialog
box used to add or edit comments.

Fig 2.52  [Comment Edit] dialog box

[Sample Name], [Operator], [Organization], and [Comment] can be added or edited. The
maximum number of characters that can be input is 62, 62, 62 and 124, respectively.

2.4.8  [Common Option]

2.4.8.1  [Kinetics...]

This function is used with time course data and calculates the enzyme activity value.

Fig 2.53  [Kinetics] dialog box

Note: Immediately after the [Kinetics] dialog box opens, the calculation range is set
to the entire region to calculate the result.

Data display field Displays time course (reaction curve) data and the
range specified with the time setting bar (from
calculation start time to calculation end time)
approximated with a first-order regression straight line
using the least squares method. Set the calculation start
time and calculation end time by dragging the time
setting bar with the mouse while watching data. The
data value of the time setting bar position is displayed in
the [Data] field on the data display.

[Start time] Enter the calculation start time.
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[End time] Enter the calculation end time.
[Factor] Enter a factor for the kinetics calculation. This value is

inherent to the sample.
<Apply> Click to execute kinetics calculation.
<Print…> Click to display the [Print] dialog box. In the [Print] dialog

box, click <OK> to print the result.

2.4.8.2  [Data Dump...]

Select [Processing] – [Data Dump…] to display the [Data Dump Parameter] dialog
box used to view measured data values. This function also allows data values to be
copied to the clipboard.

Fig. 2.54  [Data Dump Parameter] dialog box

[Dump Range:] Specify the range from which to dump data values.
[Thin out:] Enter the number of points to be thinned out.
<OK> Click to display the data values in the following dialog

box.

Fig. 2.55  [Data Dump] dialog box

<Range...> Returns to the [Data Dump Parameter] dialog box.
<Copy> Copies data to the clipboard.
<OK> Closes the dialog box.

2.4.8.3  [Move Channel...]

Select [Processing] - [CD Options] – [Move Channel …] to display the [Channel
Conversion] dialog box used to move channels (for example, channel 1 and channel
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2) in a view or pick up only data of a desired channel from data overlaid in a view or
from multiple-channel data.
This function is used in the following cases.
(1) To process the data of, for example, channels 2 to 4. That is, these data must be

moved to channel 1.
(2) To pick up only the data of a desired channel and display it in a new view.

Note: Only channel 1 data can be processed.

Fig. 2.56  [Channel Conversion] dialog box

[Select channel data:] Select the filename of the desired data from the filename
drop-down list and then designate a channel by clicking on the
up and down arrow buttons ([▲] [▼]) at right. The data shown
in the spectrum display area are rewritten with the designated
data.
When the desired data are displayed, click the <Append>
button. The designated data are registered in [New data
image:]. Data registered first are entered in channel 1.
Repeat this step to move channels.  To pick up desired data
only, register only the required data.

Note: The filename can be selected when multiple data are overlaid.

[New data image:] Displays designated data register field(s).  Maximum of four
channels, 1 to 4, from top to bottom.

<Append> Registers the current selection (displayed in the spectrum
display field) in the [New data image:] list.

<Delete> Deletes the currently selected item in [New data image:].
<Up> Moves the currently selected item up the [New data image]

list.  Used to change the registered data display channel.
<Down> Moves the currently selected item down the [New data image]

list.  Used to change the registered data display channel.
<OK> Click to close the dialog box and open the registered data in a
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new view.

2.4.8.4  [Arithmetic with Data...]

Performs arithmetic operation using data overlaid in the same channel of a view.
However, the arithmetic operation cannot be performed unless the data mode and
data interval of the data of each overlaid channel are the same.  The horizontal axis
is limited to the range in which the two data sets are overlaid.  If only one set of data
is displayed, calculation is performed between the data and a constant or constants.
Select [Processing] – [CD Options] – [Arithmetic with Data…] to display the
[Arithmetic with Data] dialog box.

Fig. 2.57  [Arithmetic with Data] dialog box

Calculation is performed according to the expression designated at the top of the
dialog box. To construct an arithmetic operation enter numerical values in each text
box as desired and select the appropriate operator from the drop-down list.

Spectrum display area The data before arithmetic operation are displayed at the top
and the result of the arithmetic operation is displayed at the
bottom.

<Apply> Click to perform calculation.
<Exchange> Exchange data S1 and S2 with each other.
<Scale...> Click to display the [Scale] dialog box used to change the

scale of the original data.
<OK> Click to perform calculation and close the dialog box. The

result of arithmetic operation is displayed in a new view.

Note: When using data overlaid in the same channel of a view, to perform
calculation between one set of data and a constant or constants enter 0 for
the coefficient of the unwanted data set.

Note: If only one set of data is displayed in the view, the dialog box shown in Fig.
2.67 is displayed. Calculation can be performed between the data and a
constant or constants.
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Fig. 2.58  [Arithmetic with Data] dialog box (with one piece of data)

2.4.8.5  [Arithmetic with Channel...]

This function performs arithmetic operation using data displayed in the same view.
Unlike the [Arithmetic with Data...] function above that performs arithmetic operation
using data overlaid in the same channel, this function performs arithmetic operation
using data freely selected from multiple channels of data displayed in a view.
Needless to say, overlaid data can also be selected.  In addition, the vertical axis
attribute can be freely selected.  The horizontal axis is limited to the range in which
the two sets of data are overlaid.

Filename display field Channel display field

Fig. 2.59  [Arithmetic with channel] dialog box

[Selection of arithmetic
 data:] group

Select the filenames of the desired data from the [S1]
and [S2] drop-down lists and then designate channels
by clicking on the up and down arrow buttons ([▲] [▼])
at right. In the example screen above, data overlaid in
channel 1 are calculated.

[Data Attribute after
 arithmetic:]

Select the vertical axis attribute of the data after
arithmetic operation.
If the vertical axis attribute changes after arithmetic
operation, click the [Select] option button and select the
vertical axis attribute from the drop-down list on the
right. For example, the result of division by single beam
(SB) will be %T.

<OK> Click to display the following dialog box.
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Fig. 2.60  [Arithmetic with Channel] dialog box

Calculation is performed according to the expression designated at the top of the
dialog box. To construct an arithmetic operation enter numerical values in each text
box as desired and select the appropriate operator from the drop-down list. Refer to
Section 2.4.11.5 for more information.  Click <Back...> to return to the previous dialog
box shown in Fig. 2.66.

2.4.8.6  [Data Accumulation]

Accumulates data overlaid in the same channel of a view and displays the result in a
new view.

Note: Data cannot be accumulated unless the data mode, data interval and
measurement range of each overlaid channel are the same.

2.4.9  [IR-option]

2.4.9.1  [ATR Conversion…]

This option converts the absorption intensity relationship between the high
wavenumber side and low wavenumber side.
This is only effective for specctra measured by the ATR method. Although calculation
can be performed for other data, the results are meaningless.

Fig. 2.61 [ATR Correction] Dialog Box
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2.4.9.2  [IF to Spectrum…]

This option converts an interferogram(IF) into a single-beam spectrum(Single).
Eleven types of apodization functions are available.

Fig. 2.62 [IF to Spectrum] Dialog Box

Spectrum display area Display the original spectrum at the top, and the single-
beam spectrum below.

[Apodization] Ste the desired spodization function here.
[Resolution] Set the spevtrum resolution here. Note that a resolution

lower than that of the interferogram cannot be set.
[Zerofilling] Set whether zero filling is to be done here.
<Apply> Click this button to perform calculation using the set

parameters and display the spectrum.

2.4.9.3  [Spectrum to IF…]

This option converts a single-beam spectrum(Single) into an interferogram(IF). There
are no parameters.

Fig.  2.63 [Spectrum to IF] Dialog Box

Spectrum display area Display the original spectrum at the top, and the
interferogram below.
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2.4.10  [FP-option]

2.4.10.1  [Phospho. Lifetime...]

Select [Processing]-[FP Options]-[Phospho. Lifetime...] to display the [Phosporescent
Lifetime Analysis] dialog box used to calculate the phosphorescent lifetime.

Note: Refer to Section 4.4 of the Appendix for more information on phosphorescent
lifetime.

Fig. 2.64  [Phosphorescent Lifetime Analysis] dialog box
[Range of denaturation] Click and drag the time setting bar in the Spectrum

display area to the desired location, or input the values
directly.

[View] Select the appropriate option button to display the
spectrum using either a photometric or logarithmic
scale.

<Scale...> Click to display the [Scale] dialog box used to change
the display scale of the spectrum.

<Customize...> Click to display the [Customize] dialog box used to
designate the printing style.

Fig. 2.65  [Customize] dialog box

[Execute] Click to calculate phosphorescent lifetime. The
calculated results will be displayed in a dialog box.



53

Fig. 2.66  [Phosphorescent Lifetime Analysis] result dialog box

[Phosphorescent Lifetime Analysis] result dialog box
<Edit...> Click to display the [Edit] dialog box used to copy the

phosphorescent lifetime analysis results to the
clipboard.

Fig. 2.67  [Edit] dialog box

<Print...> Click to display the [Print] dialog box. For details refer to
Section 2.1.7.

2.4.11  CD Options

2.4.11.1  [HT → OD…]

This function converts HT voltage data to absorbance.  To convert the currently
active view data, select [Processing]-[CD Option]-[HD -> OD...]. The converted data
are displayed in a new view.

HT data view (before conversion) Absorbance data view (after conversion)
Fig. 2.68  HT voltage to absorbance conversion

2.4.11.2  [Optical constant calculate...]

This function is used to calculate optical constants.  The types of calculation available
are shown in Table 1. The dialog box displayed differs depending on whether the
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active view contains multiple-channel data or single-channel data.  Each dialog box is
explained below.

Table 1  Optical constant calculations
Data mode (channel 1) Type of calculation Y-axis units of result view
CD Molecular ellipticity Mol.Ellip., Mol.Ellip.MG

Specific ellipticity Spc.Ellip., Spc.Ellip.MG
Molecular CD absorption Mol.CD, Mol.CD MG
CD absorption Delta OD

Mol.Ellip., Mol.Ellip.MG Molecular CD absorption Mol.CD, Mol.CD MG
ORD Molecular rotation Mol.Rotation, Mol.Rot.MG

Specific rotation Spc.Rotation, Spc.Rot.MG
LD LD Corr.

Delta Eps.(LD)
Delta E(LD)

%T Absorbance
Specific absorbance

Abs
Spc.Abs

Molecular absorbance Mol.Abs
Abs Transmittance

Specific absorbance
%T
Spc.Abs

Molecular absorbance Mol.Abs
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1) Dialog box displayed for multiple-channel data

Fig. 2.69  [Optical Constant] dialog box (multiple-channel data)

[Method:]
[Specific] Select when calculating specific ellipticity and

delta OD.
[Molecular] Select when calculating molecular ellipticity and

molecular circular dichroic absorption.
[The Specified Channel:] Check the channels to be used for the

calculation.
[Calculation Mode:] drop-down
list

Select the desired data mode for each selected
channel.

[Parameters:] group Calculation parameters. Enter the parameters
required for calculation.

[Cell Length:] Light path length of cell
[Concentration:] Sample concentration
[Magnetic field:] Magnetic field intensity
[Molecular weight:] Molecular weight

<OK> Click to perform calculation. The results are
displayed in a new view.  The units of the
vertical axis displayed in the resulting view are
shown in Table 1.
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2) Dialog box displayed for single-channel data

Fig. 2.70  [Optical Constant] dialog box (single-channel data)

[Optical Constant:] drop-down
list

Select the desired optical constant calculation
(refer to Table 1).

[Parameters:] group Calculating parameters. Enter the parameters
required for calculation. (The active parameters
vary with the type of calculation).

[Cell Length:] Light path length of cell
[Concentration:] Sample concentration
[Magnetic field:] Magnetic field intensity
[Molecular weight:] Molecular weight

<OK> Click to perform calculation. The results are
displayed in a new view.  The units of the vertical
axis displayed in the resulting view are shown in
Table 1.

2.4.11.3  [KK conversion…]

Select [Processing] - [CD Options] – [KK Conversion…] to display the [KK
Conversion] dialog box used to convert CD data to ORD or ORD data to CD.
Conversion is performed using the following Kronig-Kramers equation.
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Here, K denotes the kth electron transition.  The integrated wavelength range (from a
to b) of CD gives a wavelength which can be regarded as a baseline sufficiently far
from the wavelength region of the kth CD band.  Therefore, the CD or ORD spectrum
obtained by this equation shows partial contribution from a number of electron
transitions ranging from the near-infrared to the vacuum ultraviolet region.  For
example, an ORD spectrum converted from a CD spectrum in the visible to ultraviolet
region does not contain any contribution from electron transitions in the far ultraviolet
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to vacuum ultraviolet region.  It should be noted that for this reason, the converted
ORD spectrum and the actually measured ORD spectrum do in agree.  Direct
numerical integration is performed for calculation, however, the method proposed by
Emeis et al. (C. A. Emis et al., Proc. Roy. Soc. (London), A297, 54-65, 1967) is used
at singular points.

Fig. 2.71  [KK Conversion] dialog box

Spectrum display area Before conversion, both the top and bottom spectra display
the original spectrum. After conversion, the bottom spectrum
displays the converted spectrum.

[Thin out:] Designate the number points to be thinned out.
<Apply> Click to execute KK conversion.
<Scale...> Click to display the [Scale] dialog box used to change the

scale of the original spectrum.
<OK> Click to close the dialog box and display the result in a new

view.

Photometric modes that permit KK conversion
The following photometric modes permit KK conversion.

CD(mdeg)

Delta OD

Mol.Ellip.
Mol.Ellip.MG

Mol.CD
Mol.CD MG

Spc.Ellip.
Spc.Ellip.MG

ORD(mdeg)

Mol. Rotation
Mol.Rot MG

Spc.Rotation
Spc.Rot MG

Cautions in K/K conversion (CD to ORD conversion)
• The ORD spectrum after conversion will be distorted if either of the

wavelength end from the CD spectrum is not zero.
• Perform measurement so that the number of data points of one CD band is 50

or more when the CD spectrum is regarded as a Gaussian curve (C. A. Emis
et al. Proc. Roy. Soc. (London), A297, 54-65, 1967).

• The ORD spectrum obtained by conversion and the measured ORD spectrum
do not agree.  Since the ORD spectrum obtained by conversion is the
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contribution from only the wavelength region of the CD spectrum before
conversion, the ORD spectrum obtained by subtracting the ORD spectrum
obtained by conversion from the measured ORD spectrum represents the
contribution from outside the wavelength region of the CD spectrum before
conversion.  This principle may be applied to estimate the Cotton effect of a
wavelength region that cannot be measured.

Cautions in K/K conversion (ORD to CD conversion)
• The wavelength range of ORD that contributes to one CD band ranges from

infinitesimal to infinity.  Therefore, the ORD spectra that can be measured are
within a limited wavelength range because of instrumental limitations.
Therefore, the CD spectra after conversion are generally distorted.

• When only one Cotton effect exists and it is near the center of the
measurement wavelength range, the distortion of the CD spectrum after
conversion is relatively small.  In practice, however, it is often the case that
multiple Cotton effects exist overlapped in a short wavelength region.  In such
a case, the CD spectrum after conversion is distorted greatly.

2.4.11.4  [G Value...]

∆ε divided by ε is called G value.  It is generally expressed by the following equation.

Abs

Abs
G

∆
=

∆
=

ε
ε

The G value represents the degree of asymmetry of the absorption band.  It can be
used as an index of the asymmetric yield of asymmetric synthesis.
The equation for calculating the G value in each data mode is given below.

�G=CD(mdeg)/(32980∗Abs)
�G=∆OD/Abs
�G=Spc.Ellip/(32980∗Spc.Abs)
�G=Mol.Ellip/(3298∗Mol.Abs)
�G=Mol.CD/Mol.Abs

Note: Display the data required for calculation in the same view.

Fig. 2.72  [G-Value Calculation] dialog box

[S1:] Designate the data that will be the numerator in the G value
calculation.  First, select the filename of the desired data from
the drop-down list and then designate the data channel with
the up and down arrow buttons ([▲] [▼]).

[S2:] Designate the data that will be the denominator in the G value
calculation. The method of designating data is the same as
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[S1].
<OK> Click to perform the calculation. The dialog box closes and the

calculated data are displayed in a new view.

2.4.11.5  [pH Conversion]

Note: This function is only available when the optional [Automatic Titration
Measurement] program is installed.

When this function is executed, a new view is opened and CD value (or fluorescence,
HT or other) is displayed on the vertical axis and pH data on the horizontal axis (see
Fig. 2.73).

CD

pH

CD

pH

Concentration

Concentration

pH conversion

Fig. 2.73  pH conversion (example)
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2.5  [Window] Menu

The commands contained in the [Help] menu are described below.

[Cascade] Cascades all open views.
[Tile] Tiles all open views.
[Arrange Icons] Arranges minimized window icons.
[Close All] Closes all views. If the spectrum data has been changed or

if the data is new, a message is displayed which asks if you
wish to save before closing. Click [Yes] to save the data
before closing. Click [No] to close the view without saving.
Click [Cancel] to cancel closing the view.

Fig. 2.74  Save message

2.6  [Other] Menu

This section describes the commands contained in the [Other] menu.

[Tool Bar...] Displays the [Edit Tool Bar] dialog box used to add or
remove tool bar buttons.

[Customize...] Displays the [Customize] dialog box used to change the
view and print style options.

[Format...] Displays the [Format Setting] dialog used to set the
number of decimal places used for the X and Y axes.
The settings are applied to peak detection results and
the X and Y axes values shown in the status bar.

2.6.1  [Tool Bar]

Select [Other] - [Tool Bar…] to display the [Edit Tool Bar] dialog box used to add or
remove buttons to or from the tool bar. Of the buttons on the tool bar, there are 11
standard buttons that cannot be changed.

Fig. 2.75  [Edit Tool Bar] dialog box

[Tool Buttons] Lists the available tool bar buttons. Select buttons to be
registered from this list.
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[Registered Tool
 Buttons]

Lists the currently registered tool bar buttons. Select
buttons to be deleted from this list.

<Select> Click to add the currently selected button(s) in the [Tool
Buttons] list to the [Registered Tool Buttons] list.

<Remove> Click to remove the currently selected button(s) in the
[Registered Tool Buttons] list from the [Tool Buttons] list.

<OK> Click to apply the current settings and close the dialog
box.

2.6.2  [Customize...]

Select [Other] - [Customize] to display the [Customize] dialog box used to change the
view and print style options.

Fig.2.76  [Customize] dialog box showing the [View] tab

[View] Tab
[Apply view setting to all
spectra]

Check this box to apply the parameter
settings of [Pattern], [Font], and [Grid] in the
[View] menu to all views.

[Apply scale setting to all views] Check this box to apply the parameter
settings of [Scale] in the [View] menu to all
views.

[Auto Scale when opening or
overlaying spectra]

Check this box to use the auto scale function
for the Y-axis when opening or overlaying
spectra.

[Default for Wavenumber Axis]
group

Select the default setting for the
Wavenumber axis. Select:
1:1 for an equal interval scale
2:1 for a 1/2 scale on and after 2000 cm-1
4:1 for a 1/4 scale on and after 2000 cm-1

[Y Axis Auto Scale] group Allows customization of the settings used for
the Y-axis auto scale.

Standard Fits the Y-axis scale to the maximum and
minimum values displayed in the View.
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User define
Upper and Lower Automatically calculates the Y-axis scale

with a specified proportion of blank space
above and below the maximum and
minimum values displayed in the View.
Setting range from 0 to 20%.

No. of significant figures for Y
axis label

Specifies the number of significant figures
to be used for the Y-axis label. Setting
range from 2 to 6 significant figures. The Y-
axis label is always rounded up.

Fig. 2.77  [Customize] dialog box showing the [Print] tab

[Print] Tab
[Ask the Title before printing] Check this box to be prompted for a title

before printing.
[Print Form] group

[Fixed Form] Select to print using standard format
[Standard Form] Select to print using the standard format.
[User Form] Select to print using a template file created in

JASCO Canvas. Click the [Browse] button and
designate the JASCO Canvas template file to be
used.

[Legend] group
[Always] Select to always print a legend with spectra.
[Never] Select to never print a legend with spectra.
[When Multiple Data Displayed] Select to print a legend with spectra only

when multiple data are displayed.

2.6.3  [Format...]

Select [Other] – [Format…] to display the [Format Setting] dialog box used to set the
number of decimal places used for the X and Y axes. The settings are applied to
peak detection results and the X and Y axes values shown in the status bar.
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Fig. 2.78 [Format Setting] dialog box

[Item] Select the units to be set from the drop-down list.
[Decimal Point] Select the desired format to be applied to the units

selected in [Item].

2.7  [Help] Menu

The commands contained in the [Help] menu are described below.

[Contents] Displays the help table of contents.
[Search topic] Displays help by keyword.
[About...] Displays a dialog box containing version information for the

Spectra Analysis Program.
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3  File Find Program

The File Find program is used to search for previously saved JASCO spectrum files.
This section describes how to use the program and contains reference information.

3.1  File Find Method

Use the following procedure to search for previously saved spectra.
(1) Double-click [File Find] in the [Analysis] pane of the [Spectra Manager] window to

start the File Find program. The [File Find] window opens. The program can also
be started by selecting [File] - [Find…] in the [Spectra Analysis] program.

Fig 3.1  [File Find] window

(2) Click the  button to display the [Search Condition] dialog box.

Fig. 3.2  [Search Condition] dialog box

Select the file type, filename (wildcard characters may be used), and where to
look for the file (directory and drive).
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Note: When [Include subfolders] is selected, the program also searches in  all the
subdirectories beneath the directory selected in [Look in;].

(3) Click the<OK>button to begin searching. The search results are displayed in the
filename display area (Fig. 3.3).

Fig. 3.3  [File Find] dialog box showing search results (when file is not selected)

(4) Click the desired data file in the filename display area. A preview of the spectrum
or data information contained in the file is displayed as shown in Fig.3.4 and
Fig.3.5.

Fig. 3.4  [File Find] dialog box (spectrum preview)

Note: In Fig.3.4, a spectrum is displayed in the spectrum/data information display

area. When [Information] is selected using the  button, the spectrum is
rewritten with data information.
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Fig. 3.5  [File Viewer] dialog box (data information)

(5) Finally, click the  button to open the currently selected file. The [Spectra
Analysis] program starts, as shown in Fig. 3.6 and a new view opens, displaying
the specified spectrum.

Fig. 3.6  [Spectra Analysis] window
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3.2  File Find Program Reference

This section contains reference information for the File Find program.

Fig. 3.7  [File Find] dialog box

Note: When the [File Viewer] program is started, nothing is initially displayed in the
[File Find] dialog box.

Filename display area Displays the results of a file search. Spectrum data files
indicated by vertically-striped icons, and time course data
are indicated by clock icons.

Spectrum/data
information display area

Displays a preview of the contents of the currently selected
file. Two types of preview are available: spectrum and data
information (measurement parameters, etc.).

File menu

[Search] or 
Opens the [Search Condition] dialog box used to specify
search parameters and execute a search. Refer to Section
3.2.1 for more information.

[Open] or 
Opens the currently selected data file in the filename display
area. If not already running, the [Spectra Analysis] program
starts and the file is displayed in a new view (see Fig. 3.6).

[Exit] Exits the program.

View menu
[Toolbar] Check to display the tool bar.
[Status Bar] Check to display the [Status Bar] (at the bottom of [File Find]

dialog box).

[Graph] or 
Select to display a spectrum preview in the spectrum/data
information display area. Active when a file is selected in the
filename display area.

[Information] or 
Select to display spectrum information such as,
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measurement parameters, etc. in the spectrum/data
information display area. Active when a file is selected in the
filename display area.

Help menu
[Help Topics...] Display help table of contents.
[Search topic] Allows you to search the help topics.
[About] Displays version information for the [File Find] program.

Fig. 3.8  [About File Find] dialog box

3.2.1  [Search Condition] dialog box

File searches are conducted using the [Search Condition] dialog box. Search
parameters such as, the file type, directory and drive as well as the date and other
information can be specified.

Fig. 3.9  [Search Conditions] dialog box showing the [Name and Location] tab

[Name and Location] tab
[Type of File] Select the type of file to be searched for. The following types

are available:

JASCO Spectral Data Files
JASCO Mapping Data Files
JASCO Interval Scan Data Files
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JASCO DSC Data Files
[Named] Specify the file name to be searched for. Wild card characters

may be used (* means an unspecified string and ? means an
unspecified character). For example, in the [Name] text box,
type *.jws to search for all files with the jws extension.

[Look in] Specify the drive and directory in which to search.
[Include subfolders] Check to include all subdirectories beneath the currently

selected directory in the search.
<OK> Click to conduct the search according to the specified

parameters(file type, directory, and drive). The results are
displayed in the filename display area (see Fig. 3.3).

Fig. 3.10 [Search Conditions] dialog box showing the [Date] tab

[Date] tab
[All Files] Select to search all files.
[Find All Files Measured] Select to search files based on the option below.

[Between] Searches for files measured within a set period of
time.

[during the previous month(s)] Searches for files measured within a specified
number of months previously.

[during the previous day(s)] Searches for files measured within a specified
number of days previously.
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Fig. 3.11  [Search Conditions] dialog box showing the  [Advanced] tab

[Advanced] tab
[Instrument] Select to search for files measured using a specific

instrument. Select the instrument from the drop-down list on
the right. The instruments available are:

Infrared Spectrometer
Laser Raman Spectrometer
UV/VIS Spectrometer
Spectrofluorometer
CD/ORD
Ellipsometer

[Containing text] Select to search for files that contain a particular portion of
text in either the File name or Comments fields. Enter the text
to search with in the text box on the right.

[Operator] Select to search for files created by a specific operator.
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4  Appendix

4.1  JCAMP-DX Format Files

The JCAMP-DX file format allows data conversion between various computers and
media. The format was created by JCAMP (Joint Committee of Atomic and Molecular
Physical Data). The program has the following characteristics:

• Format file data can be easily transferred between large computers, multi-
purpose laboratory computers, common data processing systems,
workstations, and personal computers.

• Because the format files are text files, the data can be viewed or edited
using various commercially available editors.

• Peak tables and three-dimensional data can be handled in addition to
spectra.

The V-500 can save measured and calculated data in JCAMP-DX format. Data saved
in this format can be manipulated using the Grams data processing program or the
Sadtler reference program. Although JCAMP-DX has several formats, only the V-500
format is explained here. Some knowledge of ASCII code is required in order to
understand this explanation. A sample of JASCO's JCAMP-DX using Jasco FT as an
example is given below.

##TITLE= Sample name JCAMP-DX files always start with the ##TITLE= line.
##JCAMP-DX= 4.24 JCAMP-DX version
##DATA TYPE= INFRARED SPECTRUM Designation for IR spectrum.
##ORIGIN= Jasco Always Jasco.
##OWNER= Copyright(C) Contents entered in [Copyright] in Jasco FT
##DATE= 96/08/17 Measurement date
##TIME= 13:33:46
##SPECTROMETER/DATA SYSTEM=Jasco Co. Ltd., Jasco FT for Windows, Ver. 1.00
##RESOLUTION= 4.000 Nominal resolution in units shown in ##XUNITS=.
##DELTAX= 1.92905045 Interval between data points (units in ##XUNITS=)
##XUNITS= 1/CM Units of horizontal axis
##YUNITS= TRANSMITTANCE Units of vertical axis (attribute)
##XFACTOR= 1.0000 Actual value is obtained by multiplying value in 

##XYDATA= by this factor.
##YFACTOR= 0.00001
##FIRSTX= 370.3777 First value for x-axis of ##XYDATA= (actual value)
##LASTX= 4627.7920 Last value for x-axis of ##XYDATA= (actual value)
##NPOINTS= 2208 Number of data points
##FIRSTY= 74.58664 Y-axis value corresponding to ##FIRSTX= (actual 

value)
##MAXY= 91.44050Maximum value of y-axis (actual value)
##MINY= 0.46792 Minimum value of y-axis (actual value)
##XYDATA= (X++(Y..Y)) Data are written from this point on
370.3777 7458664 7164965 6797073 6463581 6262086 6216446 6313309 6520278
385.8191 6759706 6993072 7203347 7370707 7518471 7794603 7953664
------(abbreviated)
4608.5015 8470810 8478381 8484588 8489256 8495972 8500248 8504088
4623.9341 8505672 85807172 8509182
##END= JCAMP-DX files always end with the ##END= line.
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4.1.1  JCAMP-DX file structure

4.1.1.1  LDR (Labeled-Data-Records)

LDRs consist of a data label (described later) and data. LDRs start with the ## data
label flag and end with the next data label flag.

4.1.1.2  Lines

One line can contain up to 80 characters. The terminator for a line is CR-LF. LDRs
can include several lines. Therefore, CR-LF does not necessarily designate the end
of an LDR.

4.1.1.3  Data labels

A data label clarifies an LDR. Several labels are defined in the above example and
further details are provided in Section 4.1.2. Data labels include the reserved labels
defined by JCAMP as well as user defined labels that can record any information
input by the user. The Jasco FT does not employ user-defined labels.

4.1.1.4  Blocks

A block is a set of LDRs starting with ##TITLE= and ending with ##END=. A single
JCAMP-DX file can contain multiple blocks (the Jasco FT only responds to a one-
block format).

4.1.2  Reserved labels

Only JCAMP-DX reserved labels that the Jasco FT can use are described here.
Reserved labels that start with ##, and multiple labels cannot be placed on one line.

(1) ##TITLE=
All JCAMP-DX files start with ##TITLE= LDR. With the Jasco FT, the contents of
[Sample Name] come after ##TITLE=.

(2) ##JCAMP-DX=
This LDR always comes after ##TITLE=. This shows the version of the file format.

(3) ##DATA TYPE=
Defines the data form of the block. This will always be an INFRARED SPECTRUM
since only IR spectra can be saved using the Jasco FT.

Other ##DATA TYPES= include RAMAN SPECTRUM, INFRARED PEAK TABLE,
INFRARED INTERFEROGRAM, and INFRARED TRANSFORMED SPECTRUM.

(4) ##ORIGIN=
Name and address of the file creator. Jasco is always entered here.

(5) ##OWNER=
Name of the owner of the spectrum. The contents of [Copyright] in the Jasco FT are
entered here.
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(6) ##DATA=, ##TIME=
Date (yy/mm/dd) and time (hh:mm:ss) of spectrum measurement.

(7) ##SPECTROMETER/DATA SYSTEM=
Records the measurement system and data processing system. This is always Jasco
Corp., Jasco FT for Windows, Ver. 1.00.

(8) ##RESOLUTION=
Resolution in the units defined in ##XUNITS= (described later). This value differs
from ##DELTAX= for data that have undergone zero filling.

(9) ##DELTAX=
Interval between data points expressed in the units defined in ##XUNITS=. As
described above, this value differs from ##RESOLUTION= for data that have
undergone zero filling.

(10) ##XUNITS=
Units of the horizontal axis. Since the Jasco FT cannot create JCAMP-DX files from
interferograms, this value is always 1/cm (cm-1). Other #XUNITS= include
MICROMETERS, NANOMETERS, AND SECONDS.

(11) ##YUNITS=
Units of the vertical axis. The Jasco FT supports the following units (Abbreviations
used in the Jasco FT are shown in parentheses):

TRANSMITTANCE (%T), REFLECTANCE (%R), ABSORBANCE (ABS), KUBELKA-
MUNK (KM), ARBITRARY UNITS (other attributes).

(12) ##XFACTOR=, ##YFACTOR=
Data in ##XYDATA= become the actual values when multiplied by this factor.

(13) ##FIRSTX=, ##LASTX=
Value of the first and last data point on the ##XYDATA= horizontal axis (actual value).

(14) ##NPOINTS=
Number of ##XYDATA= data points.

(15) ##FIRSTY=
Value of the vertical axis at the ##FIRSTX= point (actual value).

(16) ##MAXY=, ##MINY=
Maximum and minimum values of the vertical axis (actual values).

(17) ##XYDATA=
Data are written from this point. The form of the data is (X++(Y..Y)). The first part of
the line is the X-axis data and the following numbers to CR-LF are the Y-axis data.

In the previous example, 370.3777, 385.8101, etc. are wavenumbers. 7458664 is the
datum at 370.3777 cm-1 and 7164965 is the datum at (370.3777 + ##DELTAX) cm-1 (for
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the actual values, the various numbers must be multiplied by the factor in ##YFACTOR=).
Although JCAMP-DX also has several other data formats, the Jasco FT handles only this
format.

(18) ##END=
All JCAMP-DX blocks end with ##END=.

4.1.3  User-defined labels

In addition to the labels reserved by JCAMP-DX, users can create new labels. These
labels are called user-defined labels. User-defined labels start with a $. The Jasco FT
cannot output user-defined labels.

4.1.4  Adding comments

(1) ##=
Comments starting with this label can occupy any number of lines up to the next ##
data label flag.

(2) $$
Comments starting with $$ can be placed anywhere on a line. This type of comment
can only continue to the end of the line and does not designate the end of the LDR.

4.2  Smoothing Methods

Smoothing is intended to eliminate noise components from a spectrum to improve
the signal-to-noise ratio.  It is important that the optimum method is selected
according to waveform because smoothing may distort signal components.
Four types of smoothing systems are available with the Spectrum Analysis program.
The moving average method is an averaging method that assigns an appropriate
weight to the measuring point of interest and the measuring points before and after
that point.

1. Moving average
This method is used when the spectrum bandwidth is wide, that is, when the signal
component is sufficiently smooth compared with noise.
The simple moving average method uses a rectangular coefficient as a weight
function and the smoothing effect is high, but signal distortion is high.
2. Savitzky-Golay method
This method can be used to eliminate noise from most spectra.
It uses the weight coefficient2) given by Savitzky and Golay. The weight function
changes based on the data width (convolution width) setting used in the smoothing.
3. Adaptive smoothing method
This method can be used conveniently to eliminate noise from a sharp spectrum such
as a gas spectrum.
The spectrum is hardly distorted in the peak area and the smoothing effect can be
enhanced in the baseline area by considering a coefficient based on noise dispersion
and local signal dispersion.
4. Binomial method
In this smoothing method, the weight coefficient is given by a binomial coefficient.
Compared with the Savitzky-Golay method, the binomial method has a number of
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advantages such as the entire waveform is not distorted, phase (peak position) does
not shift, and processing time is short.
Reference Literature
1) R.S.McDonald, P.A.Wilks Jr., Appl. Spectrosc. 47, 151(1988)
2) A. Savitzky, M.Golay, Anal. Chem. 36, 1627(1964)
3) P. Marchand, L. Marmet,Rev. Sci.Instrum. 54, 1034(1983)

4.2.1  Moving average method

The operating principle of the moving average method is based on a convolution
calculation, similar to that of an analog filter.
The output y(t) of an analog filter is expressed by the following equation due to
convolution of the input signal x(t) and filter impulse response h(t).

ττττττ dtxhdthxty )()()()()( −⋅=−⋅= ∫∫
∞

∞−

∞

∞−

In the moving average method, the input signal is expressed by discrete values x(i) of
n number (where i=1,2,....n) and so the smoothed value y(i) is determined as shown

below by using a ″weight function″, w(j), consisting of N (=2m +1) discrete points
(where, j = -m, .... -1, 0, 1, ..., m).
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where W is a constant for normalization.

4.2.2  Simple moving average method

This is the simplest smoothing method and uses a rectangular function as a weight
function.  Given that the width of the rectangle is N = 2m + 1, the operating
expression is given as follows.
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4.2.3  Savitzky-Golay method

This is a method of adapting the measurement waveform to a polynomial curve,
based on the minimum square error norm in the neighborhood of each sample point.
This method assumes that the measurement waveform can be expressed by a
polynomial curve in its neighborhood.  The type of weight function varies with the
order of polynomial.  A detailed table of values (weight coefficients) at each discrete
point of this weight function was first reported by Savitzky and Golay.  Therefore, the
smoothing operation can be performed simply by performing convolution using this
coefficient table.
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Discrete point
No.

25 23 21 19 17 15 13 11 9 7 5

-12 -253
-11 -138 -42
-10 -33 -21 -171
-9 62 -2 -76 -136
-8 147 15 9 -51 -21
-7 222 30 84 24 -6 -78
-6 287 43 149 89 7 -13 -11
-5 342 54 204 144 18 42 0 -36
-4 387 63 249 189 27 87 9 9 -21
-3 422 70 284 224 34 122 16 44 14 -2
-2 447 75 309 249 39 147 21 69 39 3 -3
-1 462 78 324 264 42 162 24 84 54 6 12
0 467 79 329 269 43 167 25 89 59 7 17
1 462 78 324 264 42 162 24 84 54 6 12
2 447 75 309 249 39 147 21 69 39 3 -3
3 422 70 284 224 34 122 16 44 14 -2
4 387 63 249 189 27 87 9 9 -21
5 342 54 204 144 18 42 0 -36
6 287 43 149 89 7 -13 -11
7 222 30 84 24 -6 -78
8 147 15 9 -51 -21
9 62 -2 -76 -136
10 -33 -21 -171
11 -138 -42
12 -253

Normalization
coefficient

517
5

805 305
9

226
1

323 110
5

143 429 231 21 35

This is a coefficient table by adaptation of quadratic equation.  The figure below
shows the principle of smoothing using seven discrete points.
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In this method, it is assumed that the signal waveform y(j) is expressed by the
secondary equation below at each point j between 2m+1 points (the seven points in
the above figure) around 1.

cijbijajy +−+−= )()()( 2 imiiiimj +++−+−= ,...,1,,1,...,:
Here, coefficients a, b and c are the square error in the secondary equation, where
the square error from the actually measured value x(j):
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is minimum and can be calculated by the least squares method.  At this time, the
secondary equation adaptive value y(i) at the center point i is 0.  The coefficient table
contains weight coefficients used to determine coefficient c.  Therefore, the
smoothed value y(i) at point i is calculated as follows.
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using the measurement value x(j) for 2m+1 points around this point and the value
w(j) in the coefficient table (where, j = -m,...-1,0,-1...m)

4.2.4  Adaptation smoothing method

Let us assume that the measured waveform x(i) can be expressed by the sum of
signal components (i) and the noise component n(i):

)()()( inisix +=
Let us also assume that noise n(i) is an irregular static noise (i.e. noise that does not
change with time) having an average value 0 and dispersion 2

nσ , and that the signal

is also static within a short time division. Here, the estimated value of the signal that
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satisfies the minimum least square error norm is given as )(ˆ is . That is, )(ˆ is  is the

value that minimizes ( ){ }2)()(ˆ isisE −  and is given by the following.
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(Strictly speaking, E {} represents an aggregate average, but here it is given as a
local average in the time base i direction.)
Noise dispersion 2

nσ  is determined by actual measurement. )(ix  is determined by a

simple moving average with constant width N and the estimated value of the true
signal component can be obtained by calculating the dispersion  )(2 ixσ   of the

measurement waveform in this width.

4.2.5  Binomial method

This is one of the moving average methods and is characteristic in that it can be
realized by very simple operation and no hunting appears after smoothing.
Smoothing is performed by repeat operation using the following equation a
designated number of times.

))1()(2)1((
4

1
)( ++×+−= ixixixiy

The table below gives the ″weight function″ w(j) with respect to the number of cycles
and normalizing constant W.  Compared with the Savizky-Golay method that
performs polynomial approximation, this method is characteristic in that no negative
values appears in the weight function. Thus, hunting does not occur in the
neighborhood where input changes abruptly.
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Discrete
point No.

12 11 10 9 8 7 6 5 4 3 2 1

-12 1
-11 24 1
-10 276 22 1
-9 2024 231 20 1
-8 10626 1540 190 18 1
-7 42504 7315 1140 153 16 1
-6 134596 26334 4845 816 120 14 1
-5 346104 74613 15504 3060 560 91 12 1
-4 735471 170544 38760 8568 1820 364 66 10 1
-3 1307504 319770 77520 18564 4368 1001 220 45 8 1
-2 1961256 497420 125970 31824 8008 2002 495 120 28 6 1
-1 2496144 646646 167960 43758 11440 3003 792 210 56 15 4 1
0 2704156 705432 184756 48620 12870 3432 924 252 70 20 6 2
1 2496144 646646 167960 43758 11440 3003 792 210 56 15 4 1
2 1961256 497420 125970 31824 8008 2002 495 120 28 6 1
3 1307504 319770 77520 18564 4368 1001 220 45 8 1
4 735471 170544 38760 8568 1820 364 66 10 1
5 346104 74613 15504 3060 560 91 12 1
6 134596 26334 4845 816 120 14 1
7 42504 7315 1140 153 16 1
8 10626 1540 190 18 1
9 2024 231 20 1

10 276 22 1
11 24 1
12 1

Normalizatio
n constant

1677721
6

419430
4

104857
6

26214
4

65536 16384 4096 1024 256 64 16 4

4.3  Application of the self-deconvolution method

The Fourier self-deconvolution method is used to precisely distinguish the peak
positions of each band in measurement spectra made up of multiple bands having
the deconvolution method.
(1) The program requires that Lorentzian curves can be assumed for the spectral

profile.
(2) The peak position of each band is the only representation of the shape after

processing.
The reason for this is the vertical axis information of the spectrum is sacrificed in
order to elucidate the horizontal axis information.

(3) The program cannot be applied to measurement spectra consisting of bands with
differing widths, If the halfwidth of a band is taken as s' and the halfwidth of the
deconvolution filter is taken as s, excessive deconvolution will occur when s>s'
and insufficient deconvolution will occur when s<s'.

(4) When the signal-to-noise ratio of the measurement spectrum is poor, the signal-
to-noise ratio after processing will deteriorate remarkably because, as with
differential operations, the deconvolution filter emphasizes the high frequencies.
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Principles
The program is an improved version of both the FSD (Fourier self-deconvolution)
method proposed by Kauppinen et. al. and the FIRO (Finite Impulse Response
Operator) method formulated by Jones and Shimokoshi. Both methods can be
explained in principle by the FSD method, so the FSD method will be described here.
When the real spectrum is taken to be E( )ν  the measured spectrum M ( )ν  is
generally a shape "distorted" by instrumental function G( )ν  of the measurement
system. If the system is linear, the following equation can be expressed:

M G E( ) ( ) * ( )ν ν ν= (1)
Here the * symbol expresses the convolution integral. If I xM ( )  and I xE ( )  are taken
to be the inverse Fourier transformation for M ( )ν  and E( )ν , the equation becomes
the following:

{ }
I x

F G
I xE M( )

( )
( )= −

1
1 ν

(2)

where { }F G−1 ( )ν  is the inverse Fourier transformation of G( )ν . In other words, this

shows the ideal inverse filter in the interferogram region. This filter is extremely
sensitive to noise, so an apodization function D x L( , )  is introduced into equation (2)
to cut or remove the high frequency noise with the FSD method.

{ }
I x

D x L

F G
I xE M( )

( , )

( )
( )= −1 ν

(3)

where L is the high frequency to be eliminated. The half width of G( )ν  is assumed to
have Lorentzian curve s. Therefore equation (3) becomes the following:

{ }I x
D x L

x
I xE M( )

( , )

exp
( )=

πσ
(4)

By performing a Fourier transformation on equation (4), the deconvoluted profile
E( )ν  can be obtained.

{ }E F
D x L

x
I xM( )

( , )

exp
( )ν

πσ
=












(5)

These are the principles of the FSD method. Equation (5) can be converted into the
following.

{ }E F
D x L

x
M( )

( , )

exp
* ( )ν

πσ
ν=












(6)

The FIRO method involves expanding the { }exp πσ x  in equation (6) on the spectrum

region for various types of apodization functions D x L( , ) .
In this program, in order to reduce calculation time, an algorithm which mixes the
FSD and FIRO methods is used. The deconvolution filter that is ultimately used on
the spectrum has the following form:

{ }F
D x L

x
D FL

( , )

exp
* ( , )

πσ
ν












′

where D x L( , )  and ′D FL( , )ν  are both fixed to the Bessel function, and L and FL are
handled with automatically determined values.
References
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4.4  Phosphorescent lifetime

When the fluorescence intensity at time 0 is expressed as I0, fluorescence intensity at
time t is expressed as Equation (1).

It=I0e
-t/τ (1)

Converting this equation into logarithmic form yields Equation (2).
log It = log I0�(t/τ) (2)

In Equation (2), log I0 is the y-intercept and -1/τ is the slope.
τ is defined as phosphorescent lifetime.
Standard error (StdErr) is expressed in Equation (3):

StdErr�[Σ(log It
e�log It

m)2]1/2/N (3)
N�Number of Data
log It

e�Calculated value
log It

m�Measured value

Fig. 4.1  Spectrum Data

Fig. 4.2  Phosphorescent lifetime result
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